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WARNING

To reduce fire or shock hazard, do not
expose the unit to rain or moisture.

For the customers in the U.S.A.
CAUTION

You are cautioned that any changes or
modifications not expressly approved in this
manual could void your authority to operate this
equipment.

If you have any questions about this product, you
may call:

Sony Customer Information Services Center
1-800-222-SONY (7669)

The number below is for the FCC related
matters only.

Regulatory Information

Declaration of Conformity
Trade Name: SONY

Model No.:  DPP-FP70
Responsible Party:

Sony Electronics Inc.
Address: 16530 Via Esprillo,

San Diego, CA 92127 U.S.A.

Telephone No.: 858-942-2230

This device complies with part 15 of the FCC
Rules. Operation is subject to the following
two conditions:

(1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference
that may cause undesired operation.

Declaration of Conformity
Trade Name: SONY

Model No.:  DPP-FP90
Responsible Party:

Sony Electronics Inc.
Address: 16530 Via Esprillo,

San Diego, CA 92127 U.S.A.

Telephone No.: 858-942-2230

This device complies with part 15 of the FCC
Rules. Operation is subject to the following
two conditions:

(1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference
that may cause undesired operation.
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Note:

This equipment has been tested and found to
comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules.

These limits are designed to provide reasonable

protection against harmful interference in a

residential installation. This equipment generates,

uses, and can radiate radio frequency energy and, if
not installed and used in accordance with the
instructions, may cause harmful interference to
radio communications. However, there is no

guarantee that interference will not occur in a

particular installation. If this equipment does cause

harmful interference to radio or television
reception, which can be determined by turning the
equipment off and on, the user is encouraged to try
to correct the interference by one or more of the
following measures:

— Reorient or relocate the receiving antenna.

— Increase the separation between the equipment
and receiver.

— Connect the equipment into an outlet on a circuit
different from that to which the receiver is
connected.

- Consult the dealer or an experienced radio/TV
technician for help.

For the Customer in Europe

This product has been tested and found compliant
with the limits set out in the EMC Directive for using
connection cables shorter than 3 meters (9.8 feet).

Attention

The electromagnetic fields at the specific frequencies
may influence the picture of this digital photo printer.

Notice

If static electricity or electromagnetism causes data
transfer to discontinue midway (fail), restart the
application or disconnect and connect the
communication cable (USB, etc) again.

Disposal of Old Electrical & Electronic
Equipment (Applicable in the European
Union and other European countries
with separate collection systems)

This symbol on the
product or on its
packaging indicates that
this product shall not be
treated as household
waste. Instead it shall be
handed over to the
applicable collection point
for the recycling of
electrical and electronic
equipment. By ensuring
this product is disposed of
correctly, you will help
prevent potential negative
consequences for the



environment and human health, which could
otherwise be caused by inappropriate waste handling
of this product. The recycling of materials will help to
conserve natural resources. For more detailed
information about recycling of this product, please
contact your local Civic Office, your household waste
disposal service or the shop where you purchased the
product.

NOTICE FOR CUSTOMERS IN THE
UNITED KINGDOM

A moulded plug complying with BS 1363 is fitted to this
equipment for your safety and convenience.

Should the fuse in the plug supplied need to be replaced,
a fuse of the same rating as the supplied one and
approved by ASTA or BSI to BS 1362, (i.e.marked with
G or Y mark) must be used.

If the plug supplied with this equipment has a detachable
fuse cover, be sure to attach the fuse cover after you
change the fuse. Never use the plug without the fuse
cover. If you should lose the fuse cover, please contact
your nearest Sony service station.

Sony shall assume no responsibility for any
accidental or consequential damages or loss of
the recording contents which may be caused
by use or malfunction of the printer or

memory card.

Duplication, edition, or printing of a CD, TV
programs, copyrighted materials such as pictures
or publications, or any other materials except for
your own recording or creation is limited to
private or domestic use only. Unless you hold
copyright or have permission of copyright
holders for the materials to be duplicated, use of
those materials beyond this limit may infringe the
provisions of the copyright law and be subject to
the copyright holder’s claim for damages.

When using photo images with this printer, pay
special attention not to infringe the provisions of
the copyright law. Any unauthorized use or
modification of others’ portrait may also infringe
their rights.

For some demonstrations, performances, or
exhibits, photography may be forbidden.

Backup recommendations

To avoid potential risk of data loss caused by
accidental operation or malfunction of the
printer, we recommend that you save a
backup copy of your data.

Information

IN NO EVENT SHALL SELLER BE LIABLE FOR
ANY DIRECT, INCIDENTAL OR
CONSEQUENTIAL DAMAGES OF ANY
NATURE, OR LOSSES OR EXPENSES
RESULTING FROM ANY DEFECTIVE
PRODUCT OR THE USE OF ANY PRODUCT.

Notes on LCD screen

¢ The displayed image on the screen is not
identical in picture quality and colors with the
printed image because phosphor methods or
profiles differ. Please regard the displayed
image as just a reference.

* Do not press against the LCD screen. The
screen may be discolored and that may cause a
malfunction.

* Exposing the LCD screen to direct sunlight for
long periods may cause malfunctions.

* The LCD screen is manufactured using
extremely high-precision technology so over
99.99% of the pixels are operational for
effective use. However, there may be some
tiny black points and/or bright points (white,
red, blue or green in color) that constantly
appear on the LCD screen. These points are
normal in the manufacturing process and do
not affect the printing in any way.

* Images may trail across on the LCD screen in a
cold location. This is not a malfunction.

On trademarks and copyrights

* Cyber-shot is the trademark of Sony
Corporation. I

¢ “Memory Stick”, menonvsncc », “Memory Stick
PRO”, MEMORY STICK PRO, “Memory Stick
Duo”, MEMORY STICK Dun, “Memory Stick
PRO Duo” Memory STick PRO Duo,
“MagicGate”, and MaAGICGATE /
“Memory Stick Micro”, “M2” are trademarks
of Sony Corporation.

* This unit is equipped with face recognition
feature. Sony Face Recognition technology
developed by Sony is used.

e The BLUETOOTH™, trademarks are owned
by Bluetooth SIG, Inc., U.S.A. and licensed to
Sony Corporation.

® Microsoft, Windows, Windows Vista and
DirectX are either registered trademarks or
trademarks of Microsoft Corporation in the
United States and/or other countries.

* IBM and PC/AT are registered trademarks of
International Business Machines Corporation.

¢ Intel and Pentium are the registered
trademarks or trademarks of Intel
Corporation.

o XD ~or xD-Picture Card™ is a trademark of

XD-Picture Card

Fuji Photo Film Co., Ltd.
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* CompactFlash is a trademark of SanDisk
Corporation in the U.S.A.

LAREATY is a trademark of FotoNation Inc. in
the U.S.A.

¢ All other companies and product names
mentioned herein may be the trademarks or
registered trademarks of their respective
companies. Furthermore, “™” and “®” are
not mentioned in each case in this manual.

* The raster process of true type fonts is based
on the FreeType Team software.

¢ This software is based in part on the work of
the independent JPEG Group.

o Libtiff
Copyright © 1988-1997 Sam Leffler
Copyright © 1991-1997 Silicon Graphics, Inc.
Permission to use, copy, modify, distribute,
and sell this software and its documentation
for any purpose is hereby granted without fee.

e Zlib
© 1995- 2002 Jean-loup Gailly and Mark Adler
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Notice for users

Program © 2007 Sony Corporation
Documentation ©2007 Sony Corporation

All rights reserved. This manual or the software
described herein, in whole or in part, may not be
reproduced, translated or reduced to any machine
readable form without prior written approval from
Sony Corporation.

IN NO EVENT SHALL SONY CORPORATION BE
LIABLE FOR ANY INCIDENTAL,
CONSEQUENTIAL OR SPECIAL DAMAGES,
WHETHER BASED ON TORT, CONTACT, OR
OTHERWISE, ARISING OUT OF OR IN
CONNECTION WITH THIS MANUAL, THE
SOFTWARE OR OTHER INFORMATION
CONTAINED HEREIN OR THE USE THEREOF.

By breaking the seal of the envelope of the CD-
ROM package, you accept all the terms and
conditions of this agreement. If you do not accept
these terms and conditions, please return this disk
envelope unopened, along with the rest of the
package, immediately to the dealer where you
obtained it.

Sony Corporation reserves the right to make any
modification to this manual or the information
contained herein at any time without notice.

The software described herein may also be
governed by the terms of a separate user license
agreement.

Any design data such as sample pictures provided
in this software cannot be modified or duplicated
except for the purpose of personal use. Any
unauthorized duplication of this software is
prohibited under copyright law.

Please note that unauthorized duplication or
modification of others’ portraits or copyrighted
work could infringe the rights reserved by right
holders.

( )
You may be referred to the supplied “Read
This First” when there are detailed
explanations in the leaflet.

On the illustrations and screen
status used in this manual

The illustrations and screen status used in
this manual are of the DPP-FP70 unless noted

otherwise.
4
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Before you begin

1 Printer front panel

Identlfylng the parts o (on/standby) switch/indicator

(==»Read This First)
For details, see the pages indicated in the [2] MENU button
parentheses.

Ilustrations are of DPP-FP70. The button (page 9)
locations and names of the DPP-FP90 are [4] LCD screen
identical, although the LCD screen type is

different.
L eo
e = %
2.5 type DPP-FP70 / 3.6 type DPP-FP90
[5] ENTER button
[6] Direction (A/V/<1/I>) buttons
AUTO TOUCH-UP button (page 10)
PRINT button/indicator
[9] CANCEL button
Access indicator
CompactFlash card slot
(===-Read This First) (page 74)

Paper tray compartment door
(===Read This First)

Paper tray compartment
(==»Read This First)

SD CARD (SD/miniSD card) slot
(===-Read This First) (page 74)

“Memory Stick PRO” (Standard/
Duo) slot (==»Read This First)
(page 72)

Q (zoom out)/@ (zoom in) buttons

Printer right side panel
Ink ribbon eject lever
(==»Read This First)

Ink ribbon
(=-»Read This First)

Ink ribbon compartment door
(===-Read This First)
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Printer rear panel
Handle

As illustrated below, raise the handle
when you bring the printer.

When you use the printer, close it to its
original position.

¢ When you bring the printer, make sure
to remove memory cards, external
device, and paper tray. Otherwise
malfunctions may occur.

¢ When using the DPP-FP90, set the LCD
panel to its original position.

[2] Ventilation holes

DC IN 24V jack (=~Read This First)
Connect the supplied AC power adaptor
into this connector.

Printer left side panel

[4] ¥ USB connector (page 41)
When using the printer in PC mode,

connect a PC into this connector.

@ PictBridge/EXT INTERFACE
connector (pages 35 to 38)
When using a PictBridge-compliant
digital camera, a mass-storage device
such as a USB memory or photo storage,
Bluetooth USB adaptor (DPPA-BT1*), or
other external USB device, connect it into
this connector.
(*In some regions, the Bluetooth USB
adaptor DPPA-BT1 is not sold.)

7GB
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LCD screen display

An image preview

Image data
display [1] *

[0000/A0025 |£ l

. TR

- & 00
2007/04/01
. of print

[7][8]

No image data
display ¢

Detailed

image data 4,
display
(]

Each time you press ENTER, an image
display mode changes. To display a
different image, press </P>.

Input/setting indications
Input indications and settings
information for an image are displayed.

Meaning

Icons
(= | “Memory Stick” or

o “Memory Stick Duo” input
&D

SD/miniSD Card input
IEI CompactFlash input
External Device input
Protect indication
DPOF preset indication
s Associated file indication

(Displayed when there is
an associated file such as a
motion file or a miniature
e-mail image file.)

[2] Number of the selected images/
Total number of image
Ink ribbon indication
(P: P size/C: Cleaning cartridge)
[4] Image number (folder- file
number)*
(*DCF-compatible files only. In case of
other file formats, only part of file name
will be displayed.)
[5] Operation tips
[6] Saved date (year/month/day)
Print quantity
You can set the print quantity up to 20.
¢ To increase the print quantity one
by one, press A repeatedly.
¢ To reduce the print quantity one by
one, press V briefly repeatedly.
¢ To reset the print quantity to 0
immediately, press V for more than
two seconds.

Scroll bar
Indicates the position of the image
among the total number of images.

[9] Detailed image data display



Image list
DPP-FP70

}‘g [y |

<»av/[ENIISER to select image.

2 5

Cursor (orange frame)
You can move the cursor by pressing A/
v/</D.

Operation tips
Scroll bar

Indicates the position of the image
among the total number of images.

Switching the screen
display between an image
preview and image list

You can switch an image preview
and the image list as follows:

To display the image list

In an image preview, press Q
(zoom out).

When an image is enlarged, press
Q repeatedly. An image is reduced
up to the original scale and then
the image list is displayed.

To display an image preview

In the image list, press </>/A/V
to move the cursor to the desired
image and press ENTER or @
(zoom in). The display changes
from the image list to an image
preview.

To enlarge an image preview

In an image preview, press @
(zoom in) repeatedly. The image is
enlarged to 6 steps up to the 5
times the original scale: x1, x1.5,
x2, x3, x4, and x5

9GB
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Making various printing

Correcting a failed
photo automatically
(AUTO TOUCH-UP)

What is “AUTO TOUCH-UP” feature?

The “AUTO TOUCH-UP” feature allows you to
adjust an image automatically as follows in
addition to the Auto Fine Print4 automatic
adjustment:
e Brightness adjustment using the face
recognition
Detects the face automatically and adjusts the
brightness so that the face becomes of its
optimum brightness.
® Out-of-focus reduction
Detects the out-of-focus level automatically
and corrects the image in-focus.
¢ Red-eye correction
Corrects automatically red-eye phenomenon
caused by flash.

Printing with the AUTO
TOUCH-UP adjustments

Buttons to be used in AUTO TOUCH-UP
correction print

</>/A/V/ENTER
AUTO TOUCH-UP

) NS
1 selectan image or images.
Press <I/P> repeatedly until the
desired image is displayed. When
you want to print multiple images,
set the print quantity for each image
in advance.

2 Press AUTO TOUCH-UP.
Adjustments of the selected image(s)
starts. The adjustment results will be
displayed on the screen. When a human
face is detected, the face is displayed
with frame as adjustments process.

’IOGB

To check the adjustment result
more clearly:
Press @ to enlarge the image.

To display the original image
(before adjustments) again

Press AUTO TOUCH-UP. To display
the adjusted image, press AUTO
TOUCH-UP again.

If you have selected multiple
images when pressing AUTO
TOUCH-UP

All the selected images are adjusted.
To display other images, press </P.

3 Press PRINT.
Printing of the selected image(s)
starts.

Tip
Adjustment takes effect only on the image
being printed. The original image will not be
adjusted.

¢ Depending on the image, face may not be
automatically detected. If brightness of face is
not adjusted properly, use the Edit-Adjust
menu to adjust the brightness manually (page
14).

* Depending on the image, out-of-focus
phenomenon may not be corrected. In this
case, use the Sharpness of the Edit-Adjust
menu to adjust the sharpness manually.

¢ Out-of-focus reduction does not take effect on
blur caused by shaking of the camera.

* Depending on the image, red-eye
phenomenon may not be corrected. In this
case, use Red-eye correction to make red-eye
adjustments manually (page 16).

The automatic red-eye
correction of this printer uses
the technology of FotoNation
Inc. in the US.A.

by FotoNation




Making easy printing
(Index/DPOF/AII)

The Easy Printing menu allows you to
print multiple images stored on a memory
card or an external device at one time.
The printer provides the following three
easy printing methods:
¢ Index printing
You can print a list (index) of all the
images contained in a memory card or
an external device, which allows you to
check the contents of the selected media
easily.
The number of split panes on a sheet
will be calculated automatically. Images
are printed with their corresponding
image numbers (folder number-file
number).

—el01-0001

Image numbers

Date (If Date Print
is on.)

i 1 S P L B T
R =TT

¢ DPOF preset image printing
The images which are DPOF (Digital
Print Order Format) preset for printing
are displayed with the print mark ( g )
in an image preview. You can print
those images at one time. The images
are printed with the preset number of
copies in the order they were displayed.
¢ All images printing
You can print all the images stored in a
memory card or an external device at
one time.

* For how to preset images for printing, see the
manual of your digital camera.

* Some types of digital cameras do not support
the DPOF function, or the printer may not
support some of the functions of the digital
camera.

Buttons to be used in easy printing

</>/AIV/ENTER

CANCEL

MENU

1 Press MENU on the printer.
The menu bar is displayed.

Easy Printing icon Menu bar

[Co BT K & 5 )

Easy Printing B

To exit the menu mode
Press MENU again. The previous
window is displayed.

2 Press <1/P> to select |E| (Easy
Printing) and then press ENTER.
The Easy Printing menu is displayed.

Easy Printing menu

DPOF Print

Print All

AY/[ENED: Select; (AM: End.

Continued

Buipuiid snotiena bunje -
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3 Press A/V to select “Index Print”,
“DPOF Print”, or "Print All” and
then press ENTER.

The confirmation dialog box is
displayed.

If there are no DPOF preset images when
you selected “DPOF Print,” an error
message will be displayed.

4 Press </1> to select “Yes” to start
printing or “No” to cancel
printing, and then press ENTER.
When you select “Yes,” printing
starts. During printing, the PRINT
indicator flashes and the printing
process is displayed.

To stop printing

Press CANCEL. When you are
printing multiple copies, the next
printing after the one currently
printing will be canceled.

When printing is completed, the print
paper automatically emerges on the
paper tray.

5 Remove the print paper from the
paper tray.

Tips

¢ Even if the remaining volume of the ink
ribbon is shorter than the print quantity, you
can proceed with printing. If the ink ribbon
runs out in the middle of printing and a
message appears, follow the displayed
instructions to replace the ink ribbon (see
“Read This First”).

¢ When the “Date Print” item of the Print setup
menu is set to “On”, the date the image was
shot or saved is printed (page 32).

‘IZGB

Editing an image

Displaying the Edit menu

You can display the Edit menu and edit or
add an effect to an image. You can print or
save an image being previewed.

Buttons to be used in the Edit menu

</>/A/V/ENTER

PRINT

_—F|. CANCEL
|

L

MENU

1 Display the image that you want
to edit.
Display the image in the image
preview window or move the Cursor
to the desired image in the image list.

2 Press MENU on the printer.
The menu bar is displayed.

Edit menu icon Menu bar

|
L5 .8 0 k& =)

<> /(A0 to select item.

To exit the menu mode
Press MENU again. The previous
window is displayed.

3 Press <I/> to select L (Edit) and
then press ENTER.
The Edit menu is displayed.



Cursor Edit menu

|
AR EN RO
Move

<»/[E1ED to select item.

Items  Procedures

SYC) Increases or reduces the
size of an image by
pressing the buttons on the

printer.
W Moves an image.
B Rotates an image.
141 Adjusts the picture quality
of an image.
% Adds an filter to an image.
'O Reduces the red-eye

phenomenon.

Undoes the editing just
done and resets the image
to the status before editing.

,ﬂ Saves the edited image.

] Exits the Edit menu.

Tip
You can set part of the Print setup menu items
from MENU while editing an image.

Enlarging and reducing an
image size

1 Display the Edit menu (page 12).

2 Press @ (zoom in) to enlarge an
image or  (zoom out) to reduce
the size of it.

Each time you press the button, the
image becomes larger or smaller:
@ : up to 200%

Q: up to60%

The picture quality of an enlarged image may be
deteriorated depending on its size.

Moving an image

1 Display the Edit menu (page 12).

2 Press <I/> to select ¥ (Move) and
then press ENTER.
The </>/A/V appears on the left/
right/above/down the image and
you can move the image.

3 Move the image with </I>/A/V.
The image moves to the selected

direction.
Cz W B

o

<ravto move/[EHED to fix.

4 Press ENTER.
The image is fixed to the position.

Tip
To print the image previewed, press PRINT
(page 17).
13 G8
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Rotating an image

-t

Tip

Display the Edit menu (page 12).

Press <I/I> to select B (Rotate)

and then press ENTER.

The Rotate menu is displayed.
Rotate icon Rotate menu

Av/[ENED to select item.

Press A/V to select the direction

to rotate the image and then

press ENTER.

® Rotate 90 Clockwise: Each time you
press ENTER, the image rotates 90°
clockwise.

¢ Rotate 90 Counterclockwise:
Each time you press ENTER, the
image rotates 90° counterclockwise.

To print the image previewed, press PRINT
(page 17).

Adjusting an image

1
2

Display the Edit menu (page 12).

Press </> to select (Adjust)
and then press ENTER.
The Adjust menu is displayed.

14 6

Adjust icon  Adjust menu

AdJjust

Tint
Saturation
Sharpness
= —— —

Av/[ENED to select item.

3 Press A/V to select the desired

adjustment tool and press ENTER.
The adjustment slider appears.

When “Brightness” is selected.

L2 U

> |

Adjustment slider

Move the slider to the desired

position to adjust the level.

e Brightness: Press > to brighten the
picture or < to darken it.

¢ Tint: Press > to make the picture
bluish or < to make it reddish.

* Saturation: Press > to deepen the
colors or < to lighten the colors.

* Sharpness: Press > to sharpen the
outlines or < to soften them.

Press ENTER.
The adjustment takes effect. The Edit
menu appears again.

To print the image previewed, press PRINT
(page 17).



Adding a special filter to an
image

1
2

Display the Edit menu (page 12).

Press </>> to select |'_|* (Filter) and
then press ENTER.
The Filter menu is displayed.

Filter menu Filter icon

Cross Filter

Partial Color
Sepia
Monochrome

Av/EED to select item.

Press A/V to select the desired
filter you want to add to the
image.

¢ No Filter: No special filter on the
image (default setting).

e Cross Filter: Adds a cross, starburst
effect to the light source to print an
image with sparkling impression.

¢ Partial Color: Makes the
surroundings of the subject in
monochrome to emphasize the
subject in the center.

¢ Sepia: Changes the image like an
old photograph with faded colors.

* Monochrome: Changes the image
into a black and white picture.

¢ Paint: Makes the image look like a
painted picture.

* Fish-eye: Makes the image look like
a photo taken with a fish-eye lens.

Press ENTER.
The filter takes effect.

When you have selected “Cross
Filter”, the setting window is
displayed.

Set the level and range for Cross

Filter.

(DSelect “Level” with A/V and press
ENTER, adjust level of retouch with
A/V, then press ENTER.

The higher the level you set, the
more light sources become
sparkling.

®@Select “Length” with A/V and
press ENTER, adjust length of light
with A/V, then press ENTER.

® Press A/ V to select m Then
press ENTER.

To print the image previewed, press PRINT
(page 17).

‘|5GB
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Correcting the red-eye
phenomenon

When pressing AUTO TOUCH-UP cannot
reduce the red-eye phenomenon of a
subject shot by flash, you can adjust it
manually.

If you perform additional editing, such as
enlarging, reducing the image size, rotating or
moving an image, after the red-eye correction,
the red-eye correction may not take effect.
Perform the red-eye correction after these
editorial operations.

1 Display the Edit menu (page 12).

2 Press <I/I> to select ©» (Red-eye
correction) and then press ENTER.
The adjustment frame appears on the
image, which indicates the range for
red-eye correction.

Adjustment frame

3 Adjust the position and size of the
adjustment frame.
Make the red-eye correction for the
right and left eyes separately.

To move the adjustment frame

@ Press <I/P> to select i (Move) and
press ENTER.

@ Move the frame with </>/A/V.
The frame moves in the selected
direction.

® Press ENTER.
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The frame is fixed in the current
position.

To change the size of the
adjustment frame

Press <I/D> to select @ (Enlarge) or
Q (Reduce) and press ENTER.
Each time you press ENTER, the
frame becomes larger or smaller.
You can also enlarge or reduce the
size by pressing @ (zoom in) or
(zoom out) buttons on the printer.

Tip
Make the size of the adjustment frame two
to seven times as large as the eye size.

4 Press <> to select fi7? and press
ENTER.
The range of red-eye correction is
enlarged.

5 Press ENTER.
The adjustment takes effect.
The Red-eye correction menu is
displayed.
To make a red-eye correction for other
eyes, repeat steps 3 to 5.

6 Press <> to select = and press

ENTER.
The Edit menu is displayed again.

To reset the adjustment

Press CANCEL in step 5 instead of
ENTER. The red-eye correction is
canceled and the window of step 2 is
displayed.

Tip
To print the image previewed, press PRINT
(page 17).



Printing an edited image

1 Press PRINT.
The dialog box to specify the print
quantity is displayed.

2 Press A/V to increase or decrease

the print quantity.

¢ To increase the print quantity one
by one, press A repeatedly.

* To reduce the print quantity one by
one, press V briefly repeatedly.

¢ To reset the print quantity to 1,
press V for more than two seconds.

3 Press PRINT to start printing.
The image previewed is printed.

Saving an edited image

When you select pﬂ (Save) in the Edit or
Creative Print menu, the dialog box to
select the destination to save the image is
displayed. You can save the image under a
new image number.

Tip
The selected image will not be overwritten.

1 Select the destination to save an
image.
Press A/V to select “Memory Stick”,
“SD Card”, “CompactFlash”, or
“External Device”, and press ENTER.

Select the destination
folder.

SD card |

CompactFlash
\External Device

Avto select/ENED to fix.

Tip
When you select “External Device”, a
dialog box for selecting a drive may be
displayed. Follow the instructions on the
screen to select the destination drive.

The dialog box for setting date is
displayed. You can save the set date
with the image.

2 set date.
Press A/V to select the number and
press </P> to select the day, month or
year. Then press ENTER.

Set the date.

rAelelyy / 04 / 01

<ravto set/EMED to fix.

The edited image by the Edit or
Creative Print menu is saved as a new
image. The dialog box to notify the
new image number (folder number-
file number) is displayed.

3 Press ENTER.

While saving the image, do not turn off the
printer or remove a memory card or an external
device from the printer. The printer, memory
card, USB card, or external device may be
damaged or the data may be lost.

‘|7GB
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Making a Creative
Print

With images saved in a memory card or an
external device, you can make the
following prints:

Menu You can make...

Layout Print A print with 2/4/9/13/16
split images.

Calendar Calendars with your
favorite images.
ID Photo An ID photo by specifying

vertical and horizontal
sizes for an image.

Superimpose A print with superimposed
message, handwrite
characters or illustrations.

Displaying the Creative Print
menu

Buttons to be used in Creative Print

</B>/A/V/ENTER

PRINT

1 Press MENU.
The menu bar is displayed.

']SGB

Menu bar

Creative Print menu icon

To exit the menu mode
Press MENU again. The previous
window is displayed.

2 Press </> to select % (Creative
Print) and then press ENTER.
The Creative Print menu is displayed.

et

Calendar

Superimpose

2] CreativePrint.

Lavout print

ID Photo
4rAYTO select/ENED to fix

To undo the operation midway

Press CANCEL. The window of the
previous step is displayed. Depending on
the step, you cannot undo the operation.

Tip
You can press MENU while making a Creative
Print and set part of the Print setup menu items.

To exit the Creative Print menu

* Press MENU in the middle of the
operations and select “Creative Print
Complete”.

¢ Display the preview image and then
press </B>/A/V to select 2 and press
ENTER.

The dialog box for saving an image may

be displayed (page 17).



Making layout prints

You can make a print
with 2-split, 4-split, 9-
split, 13-split, or 16-
split images.

1 Display the Creative Print menu
(page 18).

2 Press </I>/A/V to select “Layout
Print”, then press ENTER.
The Layout Print templates are
displayed.

Select form with <»av ENEER.

3 Press </>/A/V to select the
desired template, then press
ENTER.

The preview of the selected template
is displayed.

Image area

<»AY/[A0IAD to select item.

Tip
You can select and set each area in any
order.

4 Press <I/I>/A/V to select the

desired image area and press
ENTER.

The window for selecting an image is
displayed.

Press </B>/A/V to select the

desired image, and then press

ENTER.

The window used for adjusting the

image position is displayed.
Adjustment tools

Adjust the size and position of the
selected image.

Press /P> to select the desired
adjustment item, then press ENTER.

Items Procedures

Q/@ Increases or reduces the size of
an image by pressing the
buttons on the printer.

ﬁ Move the image with </B>/
A/V, and then press ENTER.

Each time you press ENTER,
I_ﬁ_ the image rotates 90°
clockwise.

AUTO TOUCH-UP
Automatically adjusts a failed
photo having problems such as
backlit, out-of-focus, or red-
eye phenomenon, by pressing
the button on the printer.

Continued
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7

Tip

Press </> to select m and press
ENTER.

The selected image is added to the
image area. When you select a
template with multiple images, repeat
the steps 4 through 7 to select an
image for each area.

To save or print the layout images previewed,
see page 17.

Making a calendar

You can make calendars
with your favorite
images.

1
2

Display the Creative Print menu
(page 18).

Press </>/A/V to select
“Calendar”, then press ENTER.
The window used for selecting the
calendar template, is displayed.

Select form with «»-Av [ENEER.

Press <I/B>/A/V to select the desired
template, and then press ENTER.
The preview of the selected template
is displayed.
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Image area Calendar area

<Av/ENED to select item.

Tip
You can select and set an image area or
calendar area in any order.

Select an image.

When you select a template with
multiple images, repeat the
procedures below to select an image
for each area.

@ Press <1/>/A/V to select an image
area, then press ENTER.
The image list is displayed.

® Press </I>/A/V to select the
desired image, then press ENTER.
The window used for adjusting the
image angle and position is
displayed. For information on
adjustment, see step 6 on page 19.

® Press </ to select [il4 and then
press ENTER.
The image is selected and displayed
in the relevant area.

Set the calendar.

@ Press <I/P>/A/V to select the
calendar area and press ENTER to
display the calendar setting
window.



... | Calendar

Calender setting
Start Y/M 2007 / 04
Start Day Sunday
Color of Day Sunday in[m|

<ravto set/EMED to fix.

@ Press A/V to select the following
items and then press /P> to select
an option.

Item Procedures

Start Y/M
Set the first month and the year
starting the calendar. Press </P>
to select the month or year and
press A/V to set the number.
Press ENTER.

Start Day
Set the day of the week (placed
furthest left in the calendar).
Press A/V to select “Sunday” or
“Monday”. Then press ENTER.

Color of Day
Set the color of Sunday and
Saturday to be displayed in the
calendar. Press B> and then A/V
to select the desired color for
Sunday and Saturday. Then press
ENTER.

® Press 4/B>/A/V to select [il4 and
then press ENTER.
The calendar is displayed in the
calendar area.

To save or print the calendar previewed, see
page 17.

Making an ID photo

You can specify the desired vertical and
horizontal sizes for an image to be printed
as an photo for an

identification card suchas | @ @A @ €
a passport or a small 1 1 2 '2'
photo stand.

1 Display the Creative Print menu
(page 18).

2 Press <I/>/A/V to select “ID
Photo”, then press ENTER.
The window used for setting the
height and width of an ID photo is
displayed.

IF1} ID Photo

Specify photo size.
Height 4.0 cm
Width 3.0 cm

Qo0
LI

Av/(ENED to select item.

Tip

You can set both height and width a value
between 2.0 to 6.0 cm.

3 Press A/V to select height or
width that you want to adjust and
press ENTER.

The cursor moves to the number
input area.

4 Press A/V to set the size and then
press ENTER.
The ID photo preview of the specified
size is displayed.

5 i you want to specify the other
size, repeat steps 3 and 4.

Continued
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6 Press A/V to select fif? and press

ENTER.
The window for selecting an image is
displayed.

Press </>/A/V to select the
desired image, and then press
ENTER.

The window used for adjusting the
image position is displayed.

Adjust the size and position of the

selected image.

Press /P> to select the desired

adjustment item, then press ENTER.
AdjuTment tools

<»/[A1E0 to select item.

Items Procedures

Q/@® Increases or reduces the size of
an image by pressing the
buttons on the printer.

Move the image with </I>/A/
V, and then press ENTER.

€

B Each time you press ENTER,
the image rotates 90°
clockwise.

I"E1  Press A/V to select the desired
adjustment item and press
ENTER. Adjustment slider is
displayed. Press <|/P> to move
the slider to the desired
position to adjust the
brightness, tint, saturation, or
sharpness level.
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Items Procedures

Changes the image into a
monochrome picture.

G»  Corrects the red-eye
phenomenon. (Page 16)

AUTO TOUCH-UP
Automatically adjusts a failed
photo having problems such as
backlit, out-of-focus, or red-
eye phenomenon, by pressing
the button on the printer.

O Press <> to select m and press
ENTER.
The preview of the ID photo print is
displayed.

Tip
To save and print the ID photo previewed, see
page 17.

An ID photo print may not be able to be used
for an identification card or passport. Please
check the requirements for the photo to be used
in the certificate before you submit the card or
passport.



Superimposing a message on
an image

You can place a preset
message, handwritten
characters or illustrations
on an image

(superimposing).

Tip

To superimpose a handwritten characters or
illustration, draw them with a black ink pen on
a white paper, shoot them with a digital camera,
and save them on a memory card. You can also
use “Superimpose characters glossary” on page

79.

1
2

Display the Creative Print menu
(page 18).

Press <I/I>/A/V to select
“Superimpose”, then press ENTER.
The window used for selecting the
background image is displayed.

Select an image for background.

@ Press <4/>/A/V to select an image
for background, then press ENTER.
The window used for adjusting the
image angle and position is
displayed. For information on
adjustment, see step 6 on page 19.

® Press /P to select m and then
press ENTER.
Preview window is displayed.

Superimpose a handwritten or
standard format message over the
background image.

B To superimpose a handwritten
message

®Press <1/> to select

(Handwritten message), then press
ENTER.

<»/ENE to select item.

The window for selecting an image
to be superimposed is displayed.
@Press </B>/A/V to select an image

you want to superimpose and press

ENTER.

Select the image of handwritten

characters or illustrations you have

prepared in advance.

The trimming cursor is displayed.
®Press </>/A/V to specify the

beginning point of the area to be

superimposed, then press ENTER.

| 4| Superimpose

Happy Birthday

<»AY/[ENII=R: Decide start point.

@Press <1/>/A/V to specify the
ending point of the area, then press
ENTER.

Continued

Buipuiid snotiena bunje -

23 GB



| 4| superimpose

|Happy Birthday

<»AY/[ENIIER : Decide end point.

The color selection window is
displayed.

To return to the previous step

Press CANCEL.

®Press </>/A/V to select the
desired color and then press
ENTER.
The window used for adjusting the
superimposed image angle and
position is displayed.
For information on adjustments, see
step 6 on page 19.

(®Press <1/ to select m and press
ENTER.
The preview of the selected image
superimposed on the background
image is displayed.

M Superimposing a standard format
message

(®Press <1/ to select (Standard
format message), then press
ENTER.
The window for selecting preset
message is displayed.

24 8

CHoppy Birtvdey |
A Happy New Year

Select fixed phrase:av,GED.

Superimpose

®@Press A/V to select the desired
message and press ENTER.

The color selection window is
displayed.

(®Press <1/>/A/V to select the
desired color and then press
ENTER.

The window used for adjusting the
message angle and position is
displayed. For information on
adjustments, see step 6 on page 19.

@Press <1/ to select m and press
ENTER.

The preview of the superimposed
message on the background image
is displayed.

To superimpose multiple handwritten

characters or preset messages

Press </ to select (Handwritten

message) or (Standard format
message) and repeat step 4.

Tip
To save and print the superimposed image
previewed, see page 17.



Viewing a slideshow

You can perform a slideshow of the
images saved in a memory card or an
external device. You can also manually
print an image being displayed.

Buttons to be used in this section

3 Press A/V to select "Switch”, and

then press ENTER.
The window to specify the way how
images are switched is displayed.

Press A/V to select “Automatic” to
switch images automatically or
“Manual” to switch them
manually. Then press ENTER.

</>/A/V/ENTER

PRINT

——F|. CANCEL

o |

1 Press MENU.
The menu bar is displayed.

Menu bar Slideshow menu icon

0B LISk S E|

Slid

1/

To exit the menu mode
Press MENU again. The previous
window is displayed.

2 Press </> to select Fl:‘» (Slideshow)

and then press ENTER.
The Slideshow menu is displayed.

Slideshow menu

s [ﬁl. .‘IL.;}‘J
Slideshow

Manual

AY/[ENED: Select; (AM: End.

5 Press A/V to select “Execute”, and
press ENTER.

o When “Automatic” is selected: The
images in the memory card or an
external device are displayed
automatically one after another.

e When “Manual” is selected:

The image with the cursor in the
image list is displayed. To switch
images, press </>.

To stop slideshow
Press CANCEL.

Tip
Whileplaying theslideshow manually, youcan
printadisplayed imageby pressing PRINT.

¢ Dependingontheimage, itmaytaketimeto
bedisplayed.

* Youcannotdisplay theimagesthatarenot
displayedas thumbnailsbecausethey are
damaged orforsomeotherreason.
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3 Press A/V to select the search key

Searchmg for an Image and press ENTER.
The dialog box used for specifying
The Search menu allows you to search a the criteria for searching is displayed.
memory card or an external device for an .
image by image number or date. 4 Ppress <> to select an item and
press A/V to specify numbers.
e When you select “By File No.”:
Youcansearchfor theimagessaved as DCF Specify the starting and ending
filesonly. numbers of the files (folder and file
Buttons to be used in this section numbers) that you want to search for:
Starting image Ending image

number number

| Image Search
By File No.

1 Press MENU. EF°¥1- 0001l~|102- 0001

The menu bar is displayed. _‘. ‘

Image Search menu icon

Tip
1 TheabovescreeniswhenaSony Cyber-
4 @\ shotdigital cameraisconnected.

¢ When you select “By Date":
Specify the starting and ending
dates of the files that you want to
search for:

Starting date Ending date

To exit the menu mode

Press MENU again. The previous
window is displayed.

4 E
| | Image Search

. By Date
8loFd/01/01~(2008 /01/01

2 Press <I/>> to select [d (Image
Search) and then press ENTER.
The Image Search menu is displayed.

Image Search menu

A

Tip
Tosearchforimagesofaspecificday,
enterthesamedateinboththeboxes.
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¢ When you select “By Folder No.":
Specify the folder number of the
images you want to search for:

4Ld

By Folder No.

' A

AY to set value/ENED to fix

5 Press ENTER.
Searching starts. When the search is
complete, the search results will be
displayed.
If no images have been found
“Noimageswerefound” willbedisplayed.

6 Press ENTER.

The searched image is displayed.

The searched results are displayed as

the status before you entered the

menu. When you searched from the

image list, “01” will be displayed with

the relevant images in the image list.

e If you selected “By File No.” and
“By Date”, “01” is displayed on the
images found to indicate their print
quantity. You can easily check the
images you selected on the image
list.

¢ If you selected “By Folder No.”, the
first or last image in the selected
folder is displayed.

Tip

To printasearched image, p ress <IP>/ANto
selectthe desired imageand then pressENTER

todisplay itin theimage preview. Press ANto
setthe printquantity and then press PRINTto
startprinting.

Filing images

Buttons to be used in this section

</>/A/NV/ENTER

CANCEL

MENU

Copying images

You can copy images between memory
cards inserted in the memory card slot or
an external device connected to the
PictBridge/EXT INTERFACE connector.

1 Press MENU.
The menu bar is displayed.

Menu bar File operation menu icon

_y File operation
» L P i

—

To exit the menu mode
Press MENU again. The previous
window is displayed.

2 Press <> to select == (File

operation) and then press ENTER.
The File operation menu is displayed.

File operation menu

— @ B B e e
YA e ST N Wp ems ||

_ File operation '

Copy selected files
Delete Image '

Memory Stick Format
. - .

Continued
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3 Press A/V to select “Copy all files”
or “Copy selected files” and press
ENTER.

* When “Copy all files” is selected,
the dialog box to select the
destination to copy the image(s) is
displayed. Skip to step 6.

* When “Copy selected files” is
selected, the image list of the
memory card or external device is
displayed.

4 Ppress </>/AIV to select the
desired image and press ENTER.
To copy multiple images, repeat this
step.
To cancel the selection
Press </B>/A/V to select the image
whose selection you want to cancel,
and press ENTER again.

5 Press MENU.
The dialog box to select the
destination is displayed.

6 Press A/V to select “Memory
Stick”, “SD Card”,
“CompactFlash”, or “External
Device”, and press ENTER.

Select copy destination.

CompactFlash |
External Device|

Avto select/EMEER to fix

Tip
Whenyouselect“External Device”,a
dialogbox forselectingadrivemaybe
displayed. Follow theinstructionsonthe
screentoselectthedestinationdrive.
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‘Youcannotcopyanimageontothe
identicalmemory card orexternaldevice
asthosecontaining theimagetobecopied.

The dialog box for selecting a folder is
displayed.

7 Press A/V to select the desired
folder and press ENTER.
The selected images are copied onto
the destination folder.

Tip
ToexittheFileoperationmenumidway, press
CANCEL.

Whilecopyingimages,donotturnoffthe
printerorremoveamemory card oranexternal
devicefromtheprinter. Theprinter,memory
card, or USBexternal devicemay bedamaged or
thedatamaybelost.

Deleting selected images

You can select and delete images on a
memory card.

1 Press MENU.
The menu bar is displayed.

2 Press </I> to select & (File
operation) and then press ENTER.

The File operation menu is displayed.

3 Press A/V to select “Delete
Image” and press ENTER.
The image list is displayed.



Trash icon

Formatting a “Memory Stick”
You can format a “Memory Stick”.

1 Press MENU.
The menu bar is displayed.
2 Press </> to select &= (File

operation) and then press ENTER.
The File operation menu is displayed.

(SNRN=31 :Select image; m :Set.

3 Press A/V to select “Memory Stick

Buipuiid snoriea Bue -

4 Press </>/AIV to move the trash Format” and press ENTER.
icon to the image you want to The confirmation dialog box is
delete, then press ENTER. displayed.

To delete multiple images, repeat this

step. 4 Press <> to select “OK” and
To cancel the selection Fr;}:essﬁlj{NTER. Stck” is f q
Press <I/B>/A/V to select the image e "Memory Stick™ 1s formatted.
whose selection you want to cancel, Notes

and press ENTER again. -

* Whenyouformata“MemoryStick”,all the

B Press MENU. imagesinsidearedeleted.

¢ During formatting, donotturnoff the printer
orremovethememory card. Theprinteror
thememory card maybedamaged. Orthe
imagemaybelost.

* Youcannotformatamemory card otherthan
the“Memory Stick” oranexternal device.

A confirmation dialog box is
displayed.

G Press <> to select “OK” and
press ENTER.
The selected images are deleted.

Tip
Toexit the File operationmenu, press CANCEL.

* During deleting, donotturnoff the printeror
remove thememory card. Theprinteror the
memory cardmaybedamaged. Orthedata
maybelost.

* Animage, oncedeleted, willbelostforever.
Beforedeletinganimage, double-check thatit
istherightone.

* Whenyoudeleteanimagewiththe
associated fileindication ( ,fheassociated
motionore-mail filewillbealsodeleted.

* Youcannotdeleteaprotected imagewiththe
protectindication(  FES¥)ora DPOF preset
indication ( g )displayed. Todeletethem,
useyour digital camera. For the details, see
theoperating instructionof thedigital
camera.
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Changing the print
settings (Print setup)
The Print setup menu allows you to

change various print settings listed on
pages 31 and 32.

Buttons to be used in this section

</>/A/V/ENTER

CANCEL

MENU

1 Press MENU.
The menu bar is displayed.

Menu bar Print setup menu icon

I
IR

Print setup
’ F -

[7.% &

+

To exit the menu mode
Press MENU again. The previous
window is displayed.

2 Press </> to select 'P (Print

setup) and then press ENTER.
The Print setup menu is displayed.

Print setup menu

Borders: Borderless

Date Print: On

Color Setting: o, i, 0

oy
AY/[ENED: Select; (EM: End.
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During the Creative Printoperations, you
cannotselecttheitemsexceptfor“Color
Setting”. (Setting items whichcannotbe
selected and changed aredisplayedin
gray.)

3 Press A/V to select the desired

setting item, and press ENTER.
The setting window for the selected
item is displayed (next page).

4 Press A/V to select the desired

setting and press ENTER.
The setting is fixed.

Tip

Toexit the Printsetup menu, press MENU.



Item

Settings

Contents

Auto Fine Print4

Photo*/
Vivid

The function automatically corrects the picture
quality so that an image may be printed in more
vivid, clear and beautiful pictures. Itis especially
effective for a darker image with low contrast. The
pictures are corrected to reproduce natural skin
colors, vivid tree leaf green, or clear sky blue.
ePhoto: Adjusts an image automatically

so that the image is printed with natural and

beautiful pictures. (Recommended)

*Vivid: Adjusts an image automatically so that
the image is printed with stronger sharpness
correction and more vivid pictures than the
Photo mode.

Tip

For theimagesshotby an Exif Print (Exif 2.21)-compliant

digital camera, they areadjusted to their optimum picture

quality.

 Theimagedataisnotcorrected.

® When printing in PCmode, the Auto Fine Print4 setting
withtheprinter driverhas priority over thesetting here.
InthePictBridgemode, thissetting holdseffective.

Off

Prints an image without any corrections.

Borders

Patternl/2

Prints an image with borders around the image. To
leave almost-equal borders in the top, bottom, right
and left around an image, select “Pattern2”.

To pint an image without being cut, select
“Pattern1”.

Whenyouselect Pattern2”, thetopandbottomedgesor
rightand leftedges maybe trimmed and printed depending
ontheimage.

Borderless*

Prints an image without blank space around the image.

When printingastandard 4:3 pictureshotby adigital
camera, thetopandbottomedgesof theimagearecutand
itisprinted asa3:2 picture.

[

Patternl Pattern 2 Borderless

*: Factory settings Continued
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Item

Settings

Contents

Date Print

On

Prints the date of shooting with an image when the
image is a file recorded in the DCF (Design rule for
Camera File system) format. To make a print with
the date of shooting, shoot an image in the DCF file
format.

When the image is saved with the printer, the date of
saving is printed.

Off*

Prints an image without the date.

Color Setting

Adjusts the colors and sharpness of a print. Press </>
to select a color element ( “R” (red), “G” (green), or
“B” (blue)) or “S” (Sharpness), and then press A/V to
set the level. You can set the levels for R, G, B in the
range from +4 to —4 and for S in the range from +7 to
0.

R: Adjusts the red and blue elements. The higher
you set the level, the more reddish the picture
becomes as if it receives red light. The lower you
set the level, the darker the picture becomes as if
light blue is added.

G: Adjusts the green and purple elements. The
higher you set the level, the more greenish the
picture becomes as if it receives green light. The
lower you set the level, the darker the picture
becomes as if red purple is added.

B: Adjusts the blue and yellow elements. The higher
you set the level, the more bluish the picture
becomes as if it receives blue light. The lower you
set the level, the darker the picture becomes as if
yellow is added.

S: The higher you set the level, the more distinct the
outlines become.

(*R: 0/G:0/B:0/5:0)
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Changing the display
and printer
preferences (Display/
Printer setup)

The Display/Printer setup menu allows
you to change the display and printer
preferences listed on page 34.

Buttons to be used in this section

</>/A/NV/ENTER

=)

=

;ﬁi CANCEL

MENU

1 Press MENU.
The menu bar is displayed.

Display/Printer

Menu bar setup menu icon

|Q%&ﬁl’p'=§|

Display/Printer setup
.

<»/[FER to select item.

To exit the menu mode
Press MENU again. The previous
window is displayed.

2 Press </> to select &= (Display/
Printer setup) and then press
ENTER.

The Display/Printer setup menu is
displayed.

Display/Printer setup menu

Date Display Drder:

Y/M/D '
LCD Backlight:

Bright

Demonstration Mode: On

-

AY/[ENED: Select; (AM: End.

3 Press A/V to select the desired
setting item, and press ENTER.
The setting window for the selected
item is displayed (next page).

To display the hidden setting items,
scroll the window with A/V.

During EditorCreative Printoperations,
someitemscannotbeselectedand
changed. Thoseitemswhichcannotbe

changed aredisplayedingray.

4 Press AV to select the desired
setting and press ENTER.
The setting is fixed.

Tip

Toexitthe Display/Printer setup menu, press
MENU.

Continued
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Item Settings Contents

Listing Order Ascending* In the image list window, the images are displayed in
the order of their image numbers, starting from the
smallest number.

Descending In the image list window, the images are displayed in
the order of their image numbers, starting from the
largest number.

Icon On In the image list window, the images without
thumbnail (miniature image used as index) data
will be displayed as an icon.

Off* In the image list window, the images without
thumbnail (miniature image used as index)
data will be displayed as its original image.

Date Display Order ~ Set the displayed order of the date (Year, Month, and Day) from the

following: Y/M/D* *M/D/Y *D/M/Y

LCD Backlight Set the brightness level of the LCD backlight from the following:

Bright*/Dark

Demonstration Mode On* A flash file demonstration to explain the functions of
the printer starts automatically after the printer has
been left unused for about 5 seconds without any
memory card or external device connected. To stop
the demonstration, press any button.

Off No demonstration flash file will be started.

Unit In the Creative Print ID photo menu, you can select the unit you use

in specifying the sizes of a photo as follows: e¢cm* e inch

Printer Information
Display

Version of the firmware and total print number will be displayed.

Language

You can select the language to display menu or messages: Japanese/
English*/French/Spanish/German/Italian/Russian/Korean/
Chinese (Simplified)/Chinese (Traditional)/Netherlands/
Portuguese/ Arabian/Persian
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Printing from a PictBridge camera or external device

Printing from the
PictBridge digital
camera

You can connect a PictBridge-compliant
digital camera and print an image directly
from your digital camera.

When printing from a PictBridge/EXT
INTERFACE connector, make sure to
remove memory card(s) from the printer
in advance.

1 set your digital camera ready for
printing with a PictBridge-
compliant printer.

The settings and operations that are
necessary before connection differ
depending on the digital camera. For
details, see the operating instructions
of the digital camera you use. (In case
of Sony Cyber-shot digital camera, for
example, select “PictBridge” mode for
the “USB Connect”.)

2 Connect the printer to the AC
power source (==m Read This
First).

3 Press O (on/standby) switch to
turn on the printer.
The & (on/ standby) indicator of the
printer lights in yellow green.

4 Connecta PictBridge-compliant
digital camera to the PictBridge/EXT
INTERFACE connector of the printer.
When you connect a PictBridge-
compliant digital camera to the
printer, “Connecting” is displayed on
the LCD display of the printer.

5 Operate the digital camera to
print an image.
The printer supports the following
prints:

¢ Single-image print

¢ All images print

¢ Index print

¢ DPOF print

* Border/Borderless print

¢ Date print

For notes during printing, please read
“Read This First”.

To PictBridge/EXT
INTERFACE connector

PictBridge
EXT INTERFACE

Camera or other
external device

To USB connector

¢ Ifyoureplaceaninkribbonwhiletheprinter

isconnected toa PictBridge-compliantdigital
camera,animagemaynotbeprinted
properly. Ifthis occurs, disconnectand then
connectthedigital camera.
Whenprinting froma PictBridge-compliant
digital camera, animagewillbepprinted
according tothesettings of the Printsetup
menuoftheprinter. Whenyousetthedate
printorborder/borderless options with your
digital camera, thedigital camera settings will
havepriority. Ifyouselect“Borderless” with
theprinterand “Border” withyourcamera,
the“Pattern1” willbe used for printing.
Forerrormessagesdisplayed onyour digital
camera, refer totheoperating instructionsof
yourdigital camera.

Youcannotusea USBhub oradigital camera
containing USBhub.
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Printing from a
Bluetooth-compliant
device

By connecting the Sony DPPA-BT1
Bluetooth USB adaptor to your printer,
you can print an image of a Bluetooth-
compliant mobile phone, digital camera,
or other device.

* Donotusethe DPPA-BT1outsidesthearea
youpurchased it. Depending on theareas, the
useof theadaptormayinfringethewave
regulationsand maybesubjecttoits penalty.

¢ Insomeregions, the Sony DPPA-BT1
Bluetooth USBadaptorisnotsold.

Compatible profiles for
Bluetooth communication

The DPPA-BT1 adaptor supports the
following profiles:

e BIP (Basic Imaging Profile)

* OPP (Object Push Profile)

For the profiles that your Bluetooth device
supports, please refer to its manual.

What is “Profile”?

Standards that enable the Bluetooth
wireless communication. There are several
profiles depending on the purposes and
product profiles to be used. To make the
Bluetooth communication possible, the
devices to be communicated should
support the same profile.

Compatible image file formats to be

printed

JPEG: DCEF 2.0 compatible, Exif 2.21
compatible, JFIF (4:4:4, 4:2:2, 4:2:0
formats Baseline JPEG)

TIFF: Exif 2.21 compatible
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BMP: 1,4,8, 16,24, 32 bit Windows
format

Some image file formats are not
compatible.

Maximum number of pixels to be
handled

8 000(H) x 6 000(V) dots (Maximum 5 MB
or less)

Printing procedures

When printing from a PictBridge/EXT
INTERFACE connector, make sure to
remove memory card(s) from the printer
in advance.

1 Connectthe printer to the AC
power source.

2 Press the () (on-standby) switch to
turn on the printer.

3 Insert the Bluetooth adaptor to
the PictBridge/EXT INTERFACE
connector of your printer.

PictBridge
EXT INTERFACE

Incaseany device, otherthan the
Bluetoothadaptor, suchasamemory card,
camera, PC, orotherexternal deviceora
USBcableis connected toany of the
memory card slots, the PictBridge/EXT
INTERFACE connector, or USB connecter
of your printer, removeitfrom theprinter
and thenconnect the Bluetoothadaptor.

4 Pprint from the Bluetooth-
complaint mobile phone, or other
device.



For printing procedures, refer to the
manual of the Bluetooth device you

use.

To select the printer from a Bluetooth-

compliant device, select “Sony DPP-
FP70 ##” /“Sony DPP-FP90 ##".
(“##” stands for the two figures from
the right of the address displayed in
the LCD screen.):

€ Bluetooth

Address 00:03:7A:33:F4(68)

Waiting for connection

When input of Pass code* is required

Input “0000”. You cannot change the pass
cord with the printer.

* Pass code is often referred to as “pass
key” or “PIN code”.

* The communication distance of the product
may vary depending on the obstacles between
the product (a human body, metal object, or
wall) and mobile phone or other device.

® Sensitivity of the Bluetooth communication
may be affected in the following conditions:

- When there is an obstacle between the
product and the mobile phone or other
product such as a human body, metal object,
ora wall.

- Were a wireless LAN is established or a
microwave oven is being used near-by, or
other electromagnetic wave is emitted.

Since a Bluetooth device and a wireless LAN
(IEEE802.11b/g) device use the same frequency
ranges, wave interferences may occur when the
product is used near a device equipped with a
wireless LAN. This may cause deterioration in
the communication speed and connection
conditions. If this occurs, take the following
measures:

- Keep a distance of at the nearest 10 m from a
wireless LAN device when you connect the
product to the mobile phone.

— Turn off the wireless LAN device in case you
should use the product within 10 m from the
wireless LAN device.

It is not guaranteed that this product works

with all devices enabled with Bluetooth

wireless technology.

Do not use the DPPA-BT1 outsides the area you

purchased it. Depending on the areas, the use

of this product may infringe the wave
regulations and may be subject to its penalty.

Sony cannot assume any responsibilities for any

information leakage that may be caused in

Bluetooth communications.

Sony cannot accept responsibilities for any

failure to satisfy the protection requirements

resulting from a non-recommended
modification or use of the product.

For customer support information, please refer

to the operating instructions of your printer.

H Cautions

Radiowavesfroma Bluetoothdevicemay
adverselyaffecttheoperationsof electrical
and medical devices,and could lead to
accidents duetomalfunctions. Makesureto
tumofftheproductand mobile phoneand do
notusethisproductin thefollowing places:

- Insidethemedical facilities, trains,
airplanes, gasstationsorotherplaces
thatmayemitflammablegas.

- nearautomaticdoorsorfirealarmsor
otherautomatically controlled devices.

Keepthisproductatleast22cmaway from
cardiacpacemakers. Radiowaves from this
productmayadversely affect theoperationof
cardiacpacemakers.
Donotdisassembleormodify this product.
Doingsocould resultininjury, electricshock,
orfire.
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Printing from an
external device

You can connect a mass-storage-complaint
digital camera, a USB memory, a photo
storage device, or other external device
and print an image directly from the
external device.

Wecannotguaranteeconnectionwithall
typesofmassstoragedevices.

Ifamemory cardisinserted in the printer, the
printercannotread thesignal froman
external device connected to the PictBridge/
EXTINTERFACE connector of the printer.
Removethememorycard,ifany.

Set your digital camera or other
external device ready for printing
with the Mass Storage-compliant
printer.

The settings and operations that are
necessary before connection differ
depending on the external device you
use. For details, see the operating
instructions of the external device. (In
case of Sony Cyber-shot digital
camera, for example, select “Normal”
mode or “Mass Storage” mode for the
“USB Connect”. )

Connect the printer to the AC
power source (==m Read This
First).

Press () (on/standby) switch to
turn on the printer.

The O (on/ standby) indicator of the
printer lights in yellow green.

4 Connect a camera or an external

device to the PictBridge/EXT
INTERFACE connector of the printer.
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Use the USB cable supplied with the
digital camera or other external
device, if necessary.

Printing in the direct mode is
possible.

To PictBridge/EXT INTERFACE
connector

PictBridge
EXT INTERFACE

Mass-storage-compliant
USB memory, digital
camera, photo storage
device, or other external
device.

Ifyouuseacommercially available USB
cable, pleaseuse theoneshorterthan3min
length.
Whiletheaccessindicator of theexternal
deviceisflashing, never turnoff the powerof
theprinteroranexternal devicenorremove
the USBcable. Thedatainside theexternal
devicemaybedamaged. Wecannot
guaranteeany damagesthatmaybecaused
bydatalossordamage.

Youcannotusea USBhub oraUSBdevice
equipped witha USBhub.

Encoded orcompressed dateby fingerprint
authenticationor password cannotbeused.
ThefollowingSony USB devices cannotbe
usedsincethey contain fingerprint
authenticationsystem ora USBhub:
USM16A/S,USM32A /S, USM64A/S,
USMI128A/S,USM256A /S, USM128B/BMS,
USM64C, USM128C, USM128F



Printing from a PC

You can print the images from a PC by

installing the supplied software on your I n Sta I I i n g t h e SOftwa re

PC and connecting it to the printer.
This section explains how to install the

supplied software on your PC and how to
use the supplied Picture Motion Browser
software to print an image.

Please also refer to the operating
instructions supplied with your PC for
operating the PC.

Installation of the software is necessary
only when you connect the printer to your
PC for the first time.

On the supplied CD-ROM

The supplied CD-ROM contains the
following software:

Printer driver for DPP-FP70/FP90: The
software describes the printer’s
requirements and enables printing from
the PC.

Picture Motion Browser: Sony’s
original software application that allows
you to handle photographs and moving
images—capturing, managing,
processing, and printing.

System requirements

To use the supplied printer driver and
Picture Motion Browser, your PC must
meet the following system requirements:

OS: Microsoft Windows Vista (*1)/
Windows XP Professional (*2)/
Windows XP Home Edition/
Windows 2000 Professional (Service
Pack 3 or later), pre-installed
(*1 )Excluding Starter. In addition, the

Picture Motion Browser does not
support the 64-bit version.
(*2 ) The 64-bit version is not supported.

(Windows 95, Windows 98 Gold
Edition, Windows 98 Second Edition,
Windows NT, Windows Millennium
Edition, other versions (ex. SP2 or
former, or Server) of Windows 2000
are not supported.)

CPU: Pentium III 500MHz or faster
(Pentium IIT 800MHz or faster is
recommended.)

RAM: 128 MB or more (256 MB or more is
recommended.)

Hard disk space: 200 MB or more
(Depending on the Windows version
you use, more space will be required.
To handle image data, you will need
additional hard disk space.)

Display:

Screen resolution:

800 x 600 pixels or more
Colors:

High Color (16-bit) or more
Required software: DirectX 9.0c or higher
(Required for the Picture Motion
Browser.)

Continued
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If a hub is used to connect the printer and
your PC, or if two or more USB devices
including other printers are connected to your
PC, a trouble may occur. If this occurs,
simplify the connections between your PC
and the printer.

You cannot operate the printer from another
USB device being used simultaneously.

Do not remove the USB cable from or connect
it to the printer during data communication
or printing. The printer may not work
properly.

Do not allow the PC connected to the printer
to switch to standby mode or hibernation
mode during printing. If you do so, the
printer may not print properly.

We cannot guarantee operations with all PCs,
even though they may meet or exceed the
system requirements.

Picture Motion Browser supports the DirectX
technology and the DirectX installation may
be required.

DirectX is available in the CD-ROM.

If the Picture Motion Browser is installed on a
PC on which the Cyber-shot Viewer is
already installed, the Cyber-shot Viewer will
be overwritten and replaced by the Picture
Motion Browser. The browsing folders once
registered in the Cyber-shot Viewer will be
automatically registered in the Picture Motion
Browser. When using the Picture Motion
Browser, you can view the folders easier than
you can when using the Cyber-shot Viewer,
as the registered folders are displayed by
group when viewing folders. With its
improved red-eye reduction adjustment and
newly-added tone curve adjustment, the
Picture Motion Browser also offers more
powerful editorial features. You can also use
the software to write data into an external
memory card for taking it outside.
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Installing the printer driver

Follow the procedures below to install the
driver.

* Before installing the driver, do not connect
the printer to the PC .

* When using the Windows Vista/XP /2000, log
on to Windows as a “Computer
administrator” user account.

® Be sure to close all running programs before
installing the software.

¢ The dialog boxes in this section are those in
Windows XP, unless otherwise specified. The
installation procedures and the dialog boxes
shown differ depending on the operating
system.

1 Turnon your PC, start Windows,
and insert the supplied CD-ROM
into the CD-ROM drive of your PC.
The installation window is displayed.

SONY
Digital Photo Printer DPP-FP60/70/90

E Installing Printer Driver D

| Installing Picture Motion Browser | _,"“'9- -
0

=~

Product Registration |

In case the installation window is not
automatically displayed, double-click the
“Setup.exe” of the CD-ROM.

Click “Installing Printer Driver”.

WN

Click “Next".
The license agreement dialog box is
displayed.

4 Read the agreement thoroughly,

and if you agree, check "l accept
this agreement” and click “Next”.
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The setup starts.

Printes Tasks

When “Sony DPP-FP60/70/90 ICTTT—
printer driver has been
successfully installed.” dialog is
displayed, click “Finish”.

10 when the installation is complete,
Connect the printer to the AC remove the CD-ROM from your PC
power source (== Read This and keep it for future use.
First). To continue to install the Picture 3
Press () (on/standby) switch to Motion Browser software, follow the g.
turn on the printer. procedures from step 2 on page 42. a

—

Connect the USB connectors of g
the printer and your PC with a * If the installation fails, remove the printer ®
USB cable (not supplied). from your PC, restart your PC, and then do (‘g
Printer driver installation starts the installation procedures from the step 2.
automatically. ¢ After installation, the “Sony DPP-FP70” or

“Sony DPP-FP90” is not set as the default
printer. Set the printer you use for each
application.

The supplied CD-ROM will be required when
you uninstall or re-install the printer driver.
Keep it in good order for possible future use.

* Before you use the printer, read the Readme
file (the Readme folder of the CD-
ROM-=English folder®Readme.txt).

When the software is installed

is displayed on the Windows
desktop, as well as a shortcut to the web
site for printer customer registration. If
you finish registration, you can find
support information at:

http:/ /www .sony.net/registration/di/

Windows PC connector

Continued
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Uninstalling the printer driver

Remove the printer driver as follows:

1 Disconnect the USB cable (not
supplied) from your printer and
the PC.

2 Click “Start” - "Printers and
Faxes”.

3 Select “DPP-FP70" or “DPP-FP90”,
and click “Delete” from the “File”
menu.

The confirmation dialog box is
displayed.

Click "Yes".

(I

Check to see that “DPP-FP70" or
“DPP-FP90"” is removed from the
“Printers and Faxes” window.

6 Click "Server Properties” from the
"File” menu, and click “Drivers”
tab in the “Printers Server
Properties” window.

7 Select “Sony DPP-FP70"” or “Sony
DPP-FP90” from the list box and
click “Remove”.

The confirmation dialog box is
displayed.

When using the Windows Vista,
deletion may not be possible. You can
safely leave it as it is.

8 Click "Yes".

9 Click “Close” to close the “Printers
Server Properties” window.

10C|ick “Start"” - "Control Panel”.
The Control Panel window is
displayed.

11 Open “Add or Remove
Programs.”
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12 select “Windows Driver Package -
Sony DPP-FP60/70/90” and click
“Change/Remove”.

The confirmation dialog box is
displayed.

1 3 Click “Yes".

Installing the Picture Motion
Browser

Follow the procedures below to install the
Picture Motion Browser.

* When using the Windows Vista/XP /2000, log
on to Windows as a “Computer
administrator” user account.

Be sure to close all running programs before
installing the software.

The dialog boxes in this section are those in
Windows XP, unless otherwise specified. The
installation procedures and the dialog boxes
shown differ depending on the operating
system.

1 Turn on your PC, start Windows,
and insert the supplied CD-ROM
into the CD-ROM drive of your PC.
The installation window is displayed
(page 40).

2 Click “Installing Picture Motion
Browser”.
The “Choose Setup Language” dialog
box is displayed.

3 Select your language and click
“Next.”
The “Location settings” dialog box is
displayed.

4 seclect the “Region” and
“Country/Area” where you use
the printer and click “Next.”

The “InstallShield Wizard” dialog box
is displayed.



5 click “Next.”
The license agreement dialog box is
displayed.

6 Read the agreement thoroughly,
and if you agree, check “I accept
the terms of the license
agreement” and click “Next”.

The dialog box used to specify the
destination location is displayed.

7 Check the destination and then
click “Next".
The “Ready to Install the Program”
dialog box is displayed.

8 Click “Install” and follow the
instructions on the screen to
proceed with installation.
When you are prompted to restart
your PC, follow the displayed
instructions to restart it.

9 When the installation is complete,
remove the CD-ROM from your PC
and keep it for future use.

e If the installation fails, perform the
installation procedures from step 2 again.

* The supplied CD-ROM will be required when
you uninstall or re-install the Picture Motion
Browser. Keep it in a safe place for possible
future use.

Uninstalling the Picture Motion
Browser

When this software is no longer needed,
remove it from your PC as follows:

1 Click “Start” - “Control Panel”.

2 Open “Add or Remove
Programs.”

3 select “Sony Picture Utility” and
click “Change/Remove” .
The software uninstallation starts.

4 Click “Finish”.

Continued
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Printing photos from
the Picture Motion
Browser

You can use the Picture Motion Browser to
print an image from your PC using P size
print paper.

1 Sstart the Picture Motion Browser
window using either of the
following methods:

* Double-click &% (Picture Motion
Browser) on the Windows desktop.

e Click “Start” - “All Programs” (or
“Programs” with Windows 2000) -
“Sony Picture Utility” - “Picture
Motion Browser.”
The “Information Tool” window is
displayed.

When the Picture Motion Browser is
started for the first time

The dialog box to register a viewed
folder is displayed. If images have
already been saved in the “My
Pictures” folder, click “Register
Now.”

If you have saved images in a folder
other than the “My Pictures” folder,
click “Register Later.” Refer to "To
register a browsing folder” (page 48).

How to access the “My Pictures”
folder

¢ In Windows 2000:
Click “My Documents” - “My
Pictures” on the desktop.

® In Windows Vista/XP:

Click “Start” - “My Pictures” from
the taskbar.
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2 Click “Start”.
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The main window of the Picture
Motion Browser is displayed.
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To switch the display of the main
window

There are 2 different versions of photo
view used in the main window as
follows:

To switch the view, click the tab
“Folders” or “Calendar.”

* “Folders” view
The images will be classified in each
registered folder and are displayed
as thumbnails.

e "Calendar” view
The images will be classified
according to the shot date and are
displayed as thumbnails on each
date of the calendar. In “Calendar”
view, you can switch the display
according to the year, month, or
hour.

In this section, “Folders” view

windows are used as examples.



3 Click the folder containing the

photos you want to print.

As an example, the “sample” folder is
selected in the following explanation.
Select the photos that you want
to print and click & (print).

The Print dialog box is displayed.

In the “Printer” drop-down list
box, select “Sony DPP-FP70"” or
“Sony DPP-FP90”. To set the
paper orientation or other print
options, go to step 6. To print,
skip to step 11.
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Items Functions

Printer Settings

e Printer: Select the printer you
are using: “Sony DPP-FP70”
or “Sony DPP-FP90”

e Paper size: To change the size,
click “Properties”.

Note: In some regions, L size

print paper is not sold.

Print Options

® Zoom the image until the print
area is full: When checked, an
image will be printed over the
entire printing area of the
paper. An edge of the photo
may be cut.
When unchecked, an image
will be printed without cutting
off.

e Print date taken: When
checked, an image is printed
with the date of shooting if the
image is a file recorded in the
DCF (Design rule for Camera
File system) format.

Properties
Specifies paper size, orientation,
picture quality and other
details.

To set the paper orientation or
other print options, click
“Properties”.

The “Properties” dialog box of the
selected printer is displayed. The
printer driver of the printer utilizes
the Universal Printer Driver, a
Microsoft common printer driver . In
the dialog boxes, there are some items
that are not used in the printer.

In the “Layout” tab, specify the
paper orientation or other
options.

&% Sony DP2-FRY0 Document Properties

Lot | Paper Dty

Continued
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Items Functions

Orientation
Select the orientation of an
image when printed:
e Portrait
*Landscape

Page Order
Select the order of the pages
when printed:
¢ Front to Back
* Back to Front

Pages Per Sheet
Specify the number of copies
per sheet to be printed.
Select “1”.

Advanced
Specifies the paper size or other
options.

Click “Advanced”.
The “DPP-FP70/FP90 Advanced
Options” dialog box is displayed.

Sony DPP-FP90 Advanced Options E]E]

[ £ Sy DPF-FRAd Advanced Dooumen: Sedings
= lgPmperjoupt
Pepar5eet | P spe(DPP-FRAOIS0)
apy o
=[] Graphic P s FF7)
= () 1mage Color Managemart
M Method: 1M Handed by Host System
T Intent: Picbures
C ;'a Daoument Options
adwanced Printing Festures: Ensbied

“alar Prirking Mods: True Color (24bpp)
= 3 Prrcer Fanires
Borderless Print: 0N
Auto Fine Print4: OFF
Auto Tourh-up: OFF
3 okar Satting

Carcl
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Items Functions

Paper/Output

e Paper Size: From the drop-
down list box, select the paper
size you actually use for
printing: P size (post card
size)/L size
Note: L size print paper is
not sold in some regions.

* Copy Count: Specify the
number of copies to be
printed.

Graphic - Image Color Management
*ICM Method: The printer does
not support the ICM method
settings. Even when you select

an option other than “ICM
Disabled”, the printed results
do not reflect the setting.
Leave the option as it is.

*ICM Intent: The printer does
not support the ICM Intent
settings. Leave the option as it
is.

Document Options

* Advanced Printing Features:
Select “Enabled” to turn on
advanced printing options
such as “Page Order”. If a
compatibility problem occurs,
disable this feature.

¢ Color Printing Mode: To print
in colors, select “True Color
(24bpp)”. To print in
monochrome, select
“Monochrome”.

For details, see the Windows

help.




Items Functions

Printer Features

® Borderless Print: To print an
image without borders, select
“ON”. To print with borders,
select “OFF”. Depending on
the application software, an
image will be printed with
borders even if “ON" is
selected. Set an image to be
printed fully in the print
range.

¢ Auto Fine Print4: Select from
“Photo”, “Vivid”, or “OFF”.
When you select “Photo” or
“Vivid”, please select “ICM

Disabled” for “ICM Method”.

Unlike direct printing from a
memory card, no Exif data is
referred. For details, see page
31.

¢ Auto Touch-up: Select “ON”
or “OFF”. When you select
“ON", please select “ICM
Disabled” for “ICM Method”.
Unlike direct printing from a
memory card, no Exif data is
referred. For the details, see
page 10.

¢ Color Setting: You can
change R, G, B, and sharpness
settings. For the details, see
page 32.

9 Inthe “Paper/Quality” tab, specify
the color or paper source.

&% Sony DP2-FPY0 Document Properties

Liout | Fepen/Cusity
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Items Functions

Tray Selection
From the “Paper Source” drop-
down list box, elect
“Automatically Select”.

Color
To print in colors, select
“Color”. To print in
monochrome, select “Black &
White”.

Advanced
The “DPP-FP70/FP90
Advanced Options” dialog box
is displayed. (page 46)
For details, see step 8.

10 click “ox~.
The “Print” dialog box is displayed
again.

11 Click "Print".
Printing starts. For the details of the
properties of the Picture Motion
Browser, see the Picture Motion
Browser help.

You cannot print a motion-picture file or RAW

data files.
Continued
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Tips

To select serial still images in the image area
of the main window, click the first image in
the series and then click the last image while
pressing the Shift key.

To select multiple still images not in a
sequence, click the images individually while
pressing the Ctrl key.

You can also print from an image preview.

To display the Windows help

Click [ on the upper right on the dialog
box and then click the desired item on the
screen.

To stop printing

1

Double-click on the printer icon
on the taskbar, and open the
“Print” dialog box.

Click the document name that
you want to cancel printing of
and then click “Cancel” from the
“"Document” menu.

The dialog box used for confirming
the deletion is displayed.

3 Click "Yes.”

The printing job is canceled.

Do not remove the job being printed. Doing so
may cause paper jam.

To register a browsing folder

The Picture Motion Browser does not
allow you to view images saved on the PC
hard disk directly. You must to register
the browsing folder as follows:

1

Click “File”-"Register Viewed
Folder,” or click 73 (Register
Folders to View).

The “Register Folders to View” dialog
box is displayed.
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2 select the folder you want to
register and then click “Register.

"
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You cannot register the whole drive.

The confirmation dialog box for
registration is displayed.

3 Click “Yes.”
Registration of the image information
in the data base starts.

4 Click "Close.”

¢ The folder you select as the destination
of the imported images will be
registered automatically.

* You cannot cancel registration of the
folder you register here.

To change the browsing folder
Click “Tools” - “Settings” - “Viewed
folders.”

Tips

e If a sub folder is contained in the source
folder, the images in the sub folder will also
be registered.

¢ When the software is first started, the
message prompting you to register “My
Pictures” will be displayed.

¢ Depending on the number of images, it may
take some tens of minutes to register images.



Printing from a commercially-
available application software

You can use a commercially-available
application software to print an image
from the DPP-FP70/FP90. Select “DPP-
FP70” or “DPP-FP90” as “Printer” in the
print dialog box, and select the print paper
size in the page setup dialog box. For
details in print settings, see steps 6 and 7
on pages 45 and 46.

On “Borderless Print” setting in the
“Printer Features”

When using an application other than the
Picture Motion Browser, an image might
be printed with borders even if you select
“ON” for the “Borderless Print” in the
“Printer Features” of the “Sony DPP-
FP70/FP90 Advanced Options” dialog
box.

When you select the borderless print
option, the printing range information for
borderless print will be supplied to the
application. Some applications, however,
may arrange and print the image with
borders within the specified range.

If this occurs, do the following to print an
image without borders:

* When you can set print range with an
application, set an image to be printed
fully in the print range. For example,
select “Full page photo print” or a
similar option.

Orientation setting

Depending on the application software
you use, orientation may not change even
if you change portrait or landscape setting.

With border/borderless setting of the
printer driver

When the application software you use
has border/borderless setting, we suggest
you select “ON” for the “Borderless Print”
in the “Printer Features” of the “Sony
DPP-FP70/FP90 Advanced Options”
dialog box as the printer driver setting.

Print quantity setting

Depending on the application software
you use, the print quantity setting of the
application you use may have priority
over the setting specified in the printer
driver dialog box.
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Troubleshooting

If trouble occurs

If you run into any problems using the printer, use the following guidance to solve the
problem. If the problem persists, consult your Sony dealer.

Power

Symptom Check Cause/Solutions

The O (on/ e Is the AC power cord < Connect the AC power cord to an AC
standby) switch | properly connected? outlet securely. (==»Read This First)
cannot be

turned on.

Displaying images

Symptom Check Cause/Solutions

The LCD screen | ¢ Does the LCD screen of 2 When a PictBridge camera or a PC is
displays no the printer show connected to the printer and the
images. “Connecting”? printer operates on the PictBridge/

PC mode, no images will be
displayed on the window. Operate
with the PictBridge camera or PC.

To display the images of a memory
card or external device, remove the
PictBridge camera or PC.

¢ Are any error messages
displayed (cause/
remedies) on the LCD
screen?

2 Follow the directions of the messages,
if any, and try to solve the problem.
(==mpage 65)

¢ Is the memory card or an
external device properly
inserted?

2 Insert a memory card or an external
device properly. (==»Read This First)

* Does the memory card or
an external device contain
images recorded with a
digital camera or other
device?

< Insert a memory card or an external
device that contains the recorded
images.

2 Check the file formats that can be
printed with the printer. (==apage
75)

¢ Is the file format
compatible with the DCF?

2 If an image is not compatible with the
DCEF, it may not be printed with the
printer even if it is displayed on the
PC monitor.
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Symptom

Check

Cause/Solutions

Some images in
the image list
are not
displayed or not
printed even if
they are
displayed.

e Are thumbnail images
displayed in the image
list?

2 If the image is displayed but cannot be
printed, the file used for printing is
damaged.

2 If there are no images stored in the
memory card or an external device, the
“No image file” message appears.

2 If an image is not compatible with DCF
(Design rule for Camera File system), it
may not be printed with the printer even
if it is displayed on the PC monitor.

* Does the mark
displayed below
appear in the image
list?

[2J

® Was the image created
on your PC?

2 If the mark shown on the left is
displayed, the image may be a JPEG file
created with your computer, or the
thumbnail data is not contained.

Select the mark and press ENTER to
display its image preview. If an image is
displayed, you can print the image. If the
same mark is displayed again, the image
is of incompatible file format and you
cannot print it with the printer.

* Does the mark
displayed below
appear in the image
list?

35/

2 If the mark shown on the left is
displayed, the image is of compatible file
format but its thumbnail data or the data
itself cannot be opened.

Select the mark and press ENTER to
display its image preview. If an image is
displayed, you can print the image. If the
same mark is displayed again, you
cannot print it with the printer.

¢ Are there more than
9 999 images saved in
the memory card or an
external device?

2 The printer can display, save, delete or
handle up to 9 999 image files. If there
are more than 9 999 images stored in a
memory card or an external device, use
the PC or PictBridge mode to display and
handle the remaining images.

Continued
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Symptom

Check

Cause/Solutions

Some images in
the image list
are not
displayed or not
printed even if
they are
displayed.

* Did you name or rename
an image file with your
pC?

= When you name or rename an image
file on your computer and its file
name includes characters other than
alphanumeric characters, the file name
may not be displayed correctly or the
image may not be displayed on the
printer (read error).

* Did you specify the print
quantity in the image list?

2 Once you have selected images in the
“Printing multiple images”
procedures, you cannot print an image
with which the cursor is just placed.
Press ENTER to select it and specify
the print quantity for the image.
(==Read This First)

¢ There are 8 or more
hierarchies in the memory
card or an external device.

2 The printer cannot display the images
saved in a folder of the 8th or higher
hierarchy.

The file name is
not displayed
correctly.

* Did you change the file
name of the image with
your PC?

= When you name or rename an image
file on your computer and its file
name includes characters other than
alphanumeric characters, the file name
may not be displayed correctly . For a
file created with a PC application, the
first 8 characters of its file name will
be displayed as the file name.

In the Edit
menu, there are
blank areas at
the top and
bottom of the
previewed
image.

e [s the previewed image
extremely stretched
vertically or horizontally?

2 If an image is extremely stretched
vertically or horizontally, blank areas
may appear in the Edit menu.

2 The standard aspect ratio of an image
shot with a digital camera is 3:4.
When an image is edited or printed in
the P size, it is saved as a more
horizontal print image and its top and
bottom edges will be cut and
displayed in black.

52 GB




Printing

Symptom

Check

Cause/Solutions

Paper does not
feed.

e Is the print paper properly
set in the paper tray?

2 If print paper is not properly loaded,
the printer may develop trouble.
(==m-Read This First)

Check the following:

¢ Insert the correct set of print paper
and ink ribbon.

¢ Load the print paper in the correct
direction in the tray.

® You can insert the maximum 20
sheets of print paper into the tray. If
the sheets exceeds 20, remove the
extra sheets.

¢ Riffle the print paper thoroughly
and insert them into the tray.

* Do not bend or fold the print paper
before printing, which may cause
malfunction with the printer.

¢ Does the ink ribbon or
print paper run out?

2 If an error message is displayed on the
screen, check the error message.

* Are you using print paper
that was not designed for
the printer?

< Use print paper designed for the
printer. If you use incompatible print
paper, the printer may develop
trouble. (==a~Read This First)

¢ [s the print paper
jammed?

2 When the printer cannot feed the print
paper, an error message is displayed.
Check paper jam. (==mpage 68)

The print paper
emerges
partially during
printing in
process.

e Is it in the middle of the
printing process?

9 The print paper may emerge a few
times during printing. Do not touch
nor pull the emerged paper. Wait for
the print paper to be fully ejected after
printing ends. As the print paper
emerges from the rear a few times
during printing, make sure to spare
enough space behind the printer
during printing. (10 cm or more)

Continued
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Printed results

Symptom Check Cause/Solutions

The printed ¢ Did you print preview 2 Depending on the type of digital
pictures are image data? camera used, preview images may be
inferior in displayed along with the primary
quality. images in the thumbnail list. The

printed quality of the preview images
will not be as good as the primary
images. Note that if you delete the
preview images, the data for the
primary images may be damaged.

¢ Did you print an image
whose size (width or
height) is smaller than
480 dots?

Is the image displayed as
follows?

= When the image is displayed as shown
on the left, it is a small image. The
printing quality is rough due to this
small image size.

< Change the image size setting of the
digital camera you are using.

¢ Did you use the Edit
menu to enlarge the
image?

< An enlarged image, depending on its
image size, will be printed with
deteriorated picture quality.

¢ Did you allow dust or
finger prints to get on the
printed surface?

= Do not touch the printing surface (the
shiny-side with no imprint).
Fingerprints on the printing surface
may result in imperfect printing.

¢ Did you use used print
paper or ink ribbon?

= Do not print on used print paper. Or,
do not use the used ink ribbon to print
an image. Printing an image twice on
the same paper will not make the
printed image thicker.

54 G8




Symptom Check Cause/Solutions

The printed ¢ Did you shoot an image in | % When you shoot an image in the RAW
pictures are the RAW file format? file format, a highly-compressed JPEG
inferior in file may be also recorded. As the

quality. printer does not support the RAW file

format, it may use the JPEG file to
print an image. A RAW file can be
printed from a PC. For details, see the
operating instructions of the digital
camera you are using.

What is a RAW file?

A RAW file is an original image file
format to save uncompressed,
unprocessed still image data captured
from a digital camera.

For whether or not a digital camera
can capture an image in the RAW file
format, see the operating instructions
of the digital camera.

* Did you use an < An AdobeRGB image file that
AdobeRGB-compliant supports the DCF 2.0 will undergo
digital camera, not color corrections, but an AdobeRGB
compatible with the DCF image file that does not support the
2.0, to shoot an image in DCEF 2.0 will be printed in vague
the AdobeRGB mode? colors without color corrections.

What is an AdobeRGB?

An AdobeRGB is a color space that the
Adobe Systems Incorporated employs
and uses as the default setting for
image processing software including
the Adobe Photoshop. The
AdobeRGB, an optional color space
extended with the DCF 2.0,
determines the color ranges widely
used in printing industry.

For whether or not a digital camera
supports the AdobeRGB, see the
operating instructions of the digital
camera.

Continued
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Symptom Check Cause/Solutions
The picture 2 Because of differences in the phosphor
quality and method or profiles of a LCD screen,
colors of the please regard the image being
image displayed on the display as just a
previewed on reference. To adjust picture quality,
the screen do either of the following:
differs from — Menu - Print setup - Color Setting
those printed. (==m~page 32)
— Menu-Edit-Adjust (==~page 14)
(The setting takes effect only on the
image being displayed.)
The printed < Because of the differences in the

image differs
when an image
is directly
printed from the
memory card or
an external
device inserted
into the printer’s
slot and when it
is printed via a
PC.

printer’s internal processing and PC
software processing, the printed
images will be different.

The date cannot

e [s “Date Print” set to
“On"?

2 Set “Date Print” in the Print setup

be printed. menu to “On”. (==m~page 32)
* Does the image support 2 The “Date Print” function of this unit
DCF? supports an image that is compatible
with the DCF standards.
The date is * Is “Date Print” set to 2 Set “Date Print” in the Print setup
printed “Off"? menu to “Off”. (==apage 32)
unintentionally.

* Was the date saved with
the image when it was
shot with the digital
camera?

< Change the camera settings.
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Symptom

Check

Cause/Solutions

The image ¢ Did you select “Pattern1” | Set “Borderless” by selecting Menu -

cannot be or “Pattern2” for Print setup - Borders. (==a~page 31)

printed fully in “Borders” in the Print

the print range. setup menu?

E;;Ciil‘; o Is the aspect ratio of the 2 Depending on the type of d.igital

. image correct? camera used, the aspect ratio of the

recorded image differs, so the image
may not be printed covering the entire
printable area.

Even if o [s the image edited and 2 When you edit and save an image with

“Borders” is set
to “Borderless”,
the image is
printed with
borders on both
sides.

saved with “Patternl” or
“Pattern2” settings?

“Pattern1” or “Pattern2” settings, it is
saved as a print image including the
blank areas. Even if you print it with
“Borderless” setting, you cannot
eliminate the borders on both sides of a
print. To print without borders, edit
and save an image with “Borderless”
setting. (==d~page 31)

The whole area
of an image
cannot be
printed.

* Did you set “Pattern1” in
the Print setup menu?

2 You can print the whole area of an
image by selecting “Patternl” in the
Print setup menu. (==~page 31)

The image is
stretched
horizontally
when printed.

¢ Did you rotate the image
or add other process?

2 Depending on the type of digital
camera used, the image may be
stretched vertically if it has been
rotated or processed using your
digital camera. This is not because of
trouble with the printer, but because
the image was rewritten with your
digital camera.

The image is
printed at an
angle.

¢ [s the paper tray inserted
properly?

2 Re-insert the paper tray firmly straight
in to the end.

There are white
lines or dots on
the printed
pictures.

The print head or paper path may be
soiled. Use the supplied cleaning
cartridge and sheet to clean the head
and path.

Continued

57 GB



Symptom

Check

Cause/Solutions

The picture is

< Adjust an image by selecting Menu -

subject are red.

too bright, dark, Edit - Adjust. (==~page 14)
reddish,

yellowish, or

greenish.

The eyes of the 9 Press AUTO TOUCH-UP button to

adjust the red-eye phenomenon.
(==~page 10)

Red-eye
correction does
not take effect
with AUTO
TOUCH-UP
button.

< Adjust for the red-eye phenomenon
by selecting Menu - Edit - Red-eye
correction. (==m~page 16)

Red-eye
correction does
not take effect
with “Red-eye

2 Set the size of the adjustment frame to
be two to seven times as large as the
eye. (==page 16)

¢ Did you enlarge, reduce

2 Red-eye correction may not work

Ic;)rrectlon the size Ojf' rotate, or properly if other editorial operations
ent. move an image after the such as enlarging, reducing the size of,
red-eye correction? rotating, or moving an image.
Perform these editorial operations first
and then perform red-eye correction.
Settings
Symptom Check Cause/Solutions
The ® Are you operating the 2 In the Creative Print menu, templates
Borderless Creative Print menu? are used and you cannot select
and “Patternl/

2” setting does
not take effect.

border/borderless prints.
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Saving or deleting an image

Symptom

Check

Cause/Solutions

You cannot save

* [s the memory card or an

2 Use your digital camera or external

an image. external device protected? device to release the protection and
then try saving again.
e Is the write-protect switch | 9 Slide the write-protect switch to the
of the memory card in the write enable position. (==page 73)
LOCK position?
¢ Is the memory card full? 2 Delete unnecessary images (==page
28), or replace it with a new memory
card with sufficient free memory
space. Save the image again.
You cannot * Is the memory card oran | > Use your digital camera or external

delete an image.

external device protected?

device to release the protection and
try printing again.

e Is the image DPOF-preset?

2 Release the DPOF preset with your
digital camera.

¢ Is the write-protect switch
of the memory card in the
LOCK position?

< Slide the write-protect switch to the
write enable position. (==page 73)

¢ Are you using a “Memory
Stick-ROM™?

2 You cannot delete an image from or
format a “Memory Stick-ROM”.

An image was

< You cannot recover an image once it is

deleted deleted.
accidentally.
The “Memory ¢ [s the write-protect switch | 3 S]ide the write-protect switch to the
Stick” cannotbe | of the memory card is in write enable position. (==apage 73)
formatted. the LOCK position?

¢ Is it a “Memory Stick- 2 You cannot delete an image from or

ROM™? format a “Memory Stick-ROM”.

The “Memory < Once the “Memory Stick” is
Stick” was formatted, all the data is deleted and
formatted cannot be recovered. To prevent
accidentally. accidental format, set the write -

protect switch to the LOCK position.
(==~page 73)

Continued
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Others

Symptom Check Cause/Solutions

You cannot 2 If the ink ribbon does not click into

insert the ink place, remove it and then re-insert it.

ribbon Only when the ink ribbon is too slack

smoothly. to be loaded, wind the ink ribbon in
the direction of the arrow to remove
the slack. (==»Read This First)

The ink ribbon 2 Turn off the O (on/ standby) switch

cannot be and then turn it on. After the motor

removed. sound stops, try to remove the ink
ribbon. If this does not solve the
problem, contact Sony service facilities
or your Sony dealer.

The print paper | ® Is an error message 2 Paper is jammed. See “If paper jams”

jams. displayed ? (==mpage 68) and remove jammed
paper from the printer. If jammed
paper cannot be removed, contact the
Sony service facilities.

Printing stops * The access indicator  The data size of an image is large and

midway. flashes in orange. it takes longer to process it for

printing. As soon as the data
processing finishes, the printer starts
printing.

¢ Is an error message

displayed?

< Paper is jammed. See “If paper jams”
(==m~page 68) and remove jammed
paper from the printer. If jammed
paper cannot be removed, contact the
Sony service facilities.

* Any indicators light or
flash.

= If no indicator is lit, the thermal head
may be overheated. Leave the printer
until the head cools down and the
printer resumes printing.
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Connecting with a digital camera

Symptom

Check

Cause/Solutions

The PictBridge
mark does not
appear on the
LCD screen of
the digital

camera.

e Is the digital camera
connected correctly?

= Connect the cable correctly.

o Is the O (on/ standby)
switch turned on?

2 Turn on the O (on/ standby) switch

* Does the firmware of your
digital camera support the
printer?

< See the manual supplied with your
camera, or consult with the
manufacturer.

¢ Is “Connecting”
displayed?

2 The message is not displayed while the
printer is in the Edit, Creative Print, or
other menu modes. Exit the menu and
then connect the cable again.

< Disconnect the digital camera and the
printer and then connect them again. Or
turn off and then on the printer and the
digital camera.

¢ [s the USB setting of your
camera in PictBridge mode?

2 Set the USB setting of your camera to
the PictBridge mode.

¢ Is printing in process?

< Connect the cable again after printing
is complete.

You connect and
disconnect the
USB cable, but
nothing happens.

9 The printer has developed an over-
current error. Unplug the AC power
cord of the printer, plug it in again,
and then press the O (on/ standby)
switch to recover from the error.

You cannot stop
printing even if
you pressed
CANCEL.

2 The next print from the one currently
printed will be canceled.

2 Depending on the digital camera you
use, you cannot cancel printing from the
printer. Operate the digital camera to
stop printing. Refer to the operating
instructions of the digital camera.

You cannot
make Index
printing.

e Is the message “Could not
create printing data for
some images.” displayed?

2 The printer cannot print Index print of
the DPOF printing. To make Index
printing, insert the memory card
directly (=-a~Read This First) or use a
mass storage external device
(==page 38).

Continued
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Connecting with a computer

Symptom

Check

Cause/Solutions

The images of
the memory
card or an
external device
inserted in the
printer are not
displayed on the
PC.

2 The printer does not provide the
function for viewing the memory card
or an external device images from the
printer.

You lost the
supplied CD-
ROM and want
to obtain a new
one.

2 Please download the printer driver
from the Customer support home
page (==m~page 77). Or contact your
Sony dealer.

The printer
driver cannot be
installed.

® Are you sure that you
have followed the
installation procedures
correctly?

2 Follow the procedures in the
operating instructions to install the
driver (==apage 40). If an error
occurs, restart your computer and do
the installation procedures again.

e Is another application
program running?

2 Exit all applications and then install
the driver again.

* Did you specify the CD-
ROM as the installation
CD-ROM correctly?

< Double-click My Computer, and then
the CD-ROM icon in the open
window. Follow the procedures in the
operating instructions to install the
driver.

2 The USB driver may not be installed
properly. Follow the operating
instructions to install the USB driver
again.

¢ Can you read the CD-
ROM with Explorer?

= If there is an error with the CD-ROM,
you may not be able to read it. If an
error message is displayed on your
PC, check the contents and remove the
source of the problem. Then install
the printer driver again. For details on
the error contents, see the operating
instructions of your PC.
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Symptom Check Cause/Solutions

The printer ¢ Is there an anti-virus 21If there is an anti-virus program or other
driver cannot be | program or other program running on the system, exit it
installed. program running on and then start installing the driver.

the system?

¢ Did you log onto
Windows Vista/XP/
2000 Professional using
an Administrator user
account?

= To install the driver in Windows Vista/
XP /2000 Professional, log onto Windows
using an Administrator user account.

The printer does
not respond to
the printing
order from the
PC.

9 If there is no trouble displayed on the
Windows desktop, check the printer’s
LCD screen.

If the printer shows trouble, do the

following:

1. Turn off the O (on/ standby) switch
then turn it on again.

2. Disconnect the power cable, wait for 5
to 10 seconds, and then connect the
cable again.

3. Restart your computer.

If these do not solve the problem, consult

with your Sony dealer or service

facilities.

¢ Is an error message
displayed stating that
an error was detected
in output of documents
via USB?

- Remove the USB cable and then connect
it again.

An image is
printed with
borders even if I
select
“Borderless”.

¢ Are you using an
application software
other than Picture
Motion Browser?

< When using an application other than the
Picture Motion Browser, an image might
be printed with borders even if you select
borderless print.
When you can set border/borderless
with an application, set an image to be
printed fully in the print range even if it
is printed over the range.

Continued
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Symptom Check Cause/Solutions

Print quantity 2 Depending on the application you use,
specified in the the print quantity setting of the

“Pages Per application you use may have priority
Sheet” in the over the setting specified in the printer
“Layout” tab of driver dialog box.

the “Sony DPP-

FP70/FP90

Properties”

dialog box does

not match the
actual print
quantity and
printed results.

Colors of the
printed image
from a PC are
different from
those printed
from a memory
card.

< Since the process in printing an image
from a memory card differs that in
printing from a PC, the colors may not
be exactly identical.
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If an error message appears

If an error occurs, the following error messages may be displayed on the LCD screen.

Follow the solution described here to solve the problem.

Printer

Error messages

Meaning/Solutions

Error occurred with printer. Turn it
off and on, then retry.

< An error has occurred with the printer. Unplug
the AC power cord of the printer, connect it
again and then try operating again. If this occurs
again, consult with your Sony dealer or Sony

service facilities.

Memory cards and external device

Error messages

Meaning/Solutions

No Memory Stick./No
CompactFlash card./No SD Card./
No External Device.

< A memory card or an external device is not inserted
into their slot. Or the external device is not
connected. Insert the memory card or an external
device. (==mRead This First)

An incompatible Memory Stick/
CompactFlash card/SD Card/
External Device is inserted.

= A memory card or an external device that the
printer does not support is inserted. Use a
compatible memory card or device. (==m~pages 72
to 75)

No image file.

2 There are no image files in the memory card or an
external device that the printer can handle.
Connect a memory card or device that contains
images that can be displayed with the printer.

No DPOF file.

2 There are no DPOF-preset image files in the
memory card or an external device. Specify the
print (DPOF) mark with your camera.

Cannot delete a protected image.

2 To delete a protected image, cancel protection on
your camera.

You cannot delete a DPOF image.

2 To delete a DPOF-preset image, cancel the print
(DPOF) mark on your camera.

Continued
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Error messages

Meaning/Solutions

Protected. Cancel protect then try
again.

2 The “Memory Stick” is write-protected. Release
the write-protection. (==a~page 73)

The Memory Stick/CompactFlash
card/SD Card /External Device is
full.

2 There is no free memory space in the selected
memory card or external device. Delete
unnecessary images or replace with a one having
sufficient memory space.

The Memory Stick/CompactFlash
card/SD Card/External Device has
trouble.

Write error in the Memory Stick/
the CompactFlash card/the SD
Card/the External Device.

Memory Stick Format Error

< An error may have occurred. If these messages
appear frequently, check the memory card or an
external device status with another device.

*In case of an external device

An external device might be write-protected.
Release the write-protection setting of the device
you use. A built-in memory of a digital camera
may be write-protected.

Memory Stick is protected.

2 A protected “Memory Stick” is inserted. To save
or edit the images with the printer, use the device
you are using to cancel protection.

External devices and PictBridge-compliant devices

Error messages

Meaning/Solutions

Incompatible USB device.
Check device’s USB setting.

2 A USB device that the printer does not support
may be connected. Or, the USB settings of the
connected device may be incompatible. Refer to
the operating instructions of the USB device you
are using.

USB hub or device with built-in
hub not supported.

2 Connect the device directly to the printer or use a
device that does not contain a USB hub function.

Write error in External Device.

< An external device might be write-protected.
Release the write-protection setting of the device
you use. A built-in memory of a digital camera
may be write-protected.
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Ink ribbon

Error messages

Meaning/Solutions

No ink ribbon. Insert ink ribbon
and press [PRINT].

No ink ribbon. Insert P size ink
ribbon and press [PRINT].

< The ink ribbon is not inserted in the printer. Set
the ink ribbon into the printer. (==Read This
First) If “cleaning cartridge” is displayed, set the
cleaning cartridge.

End of ink ribbon

End of ink ribbon. Insert P size ink
ribbon and press [PRINT].

2 Replace it with a new ink ribbon.
(==mRead This First)

Ink ribbon type incorrect. Insert P
size ink ribbon and press [PRINT].

9 Set a ink ribbon and print paper of the displayed
size. (==mRead This First)

Print paper

Error messages

Meaning/Solutions

No paper tray. Insert paper tray
containing P size print paper and
press [PRINT].

No print paper. Set the print paper
for the P Size and press [PRINT].

9 There is no print paper in the printer.

— The paper tray is not set in the printer.

— The print paper is not set in the paper tray.

— The print paper has run out.

In either case, set the print paper in the tray and
set the paper tray into the printer. (==aRead
This First)

Cleaning sheet is not placed.
Set the cleaning sheet and press
[PRINT].

< There is no cleaning sheet in the paper tray.
Insert the cleaning sheet into the paper tray and
set the paper tray into the printer.

Wrong print paper.
Set the print paper for the P Size
and press [PRINT].

2 The print paper and ink ribbon do not match.
Check the ink ribbon size actually loaded in the
printer and set the print paper for the identical
size. (==mRead This First)

Paper jam. Remove Print Paper.

< Paper jams. See “If paper jams” (==mpage 68)
and remove jammed paper from the printer. If
the jammed paper cannot be removed, contact
the Sony service facilities.
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If paper jams

If the print paper jams, an error message is
displayed and you cannot make printing.
Please do not remove the paper tray and
ink ribbon from the printer, and remove
the jammed paper.

In case you removed the paper tray, do not
re-insert the paper tray until the jammed
paper is ejected.

1 Turn off the power of the printer
and then turn it on.
Please wait for the print paper to be
ejected automatically.

Jammed paper

2 Remove the ejected print paper
from the printer.

3 Remove the paper tray and ink
ribbon from the printer and check
to see if there is no jammed print
paper inside.

Check to see if
there is jammed
paper.

If any, remove
it.

If you cannot remove the jammed paper, contact
your Sony dealer.

68 GB

Cleaning the inside of
the printer

If white lines or periodical dots are printed
on the pictures, use the cleaning cartridge
and cleaning sheet supplied to clean inside
the printer.

Before start cleaning the printer, please
remove a memory card, external device, or
USB cable from the printer.

1 Open the ink ribbon compartment
door and if there is an ink ribbon
for printing, remove it.

2 Insert the supplied cleaning
cartridge into the printer and
close the ink ribbon compartment
door.

3 Remove the paper tray from the
printer. If there is print paper in
the tray, remove it.



4 place the cleaning sheet into the
paper tray with the no-imprint
side facing up.

surface without
imprints

5 setthe paper tray into the printer
and press PRINT.
The cleaning cartridge and cleaning
sheet will clean inside the printer.
After the cleaning is finished, the
cleaning sheet is automatically ejected.

6 Remove the cleaning cartridge
and sheet from the printer.

Tip
Keep the cleaning cartridge and cleaning sheet
together for future cleaning.

When cleaning ends

Set the ink ribbon and print paper into the
printer.

e Carry out cleaning when there are white lines
or dots on the print.

* When you can obtain proper printing
performances, cleaning will not improve the
printed picture quality.

* Do not place the cleaning sheet on the print
paper and carry out cleaning, which may
cause paper jam or other troubles.

e If a cleaning does not improve printed picture
quality, please carry out cleaning a couple of
times.

* You cannot clean the printer while it is
connected to a PC or a PictBridge camera.
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Additional information

Precautions

On safety

* Be careful not to set or drop any heavy
objects on the power cord, or to damage
the power cord in any way. Never
operate this printer with a damaged
power cord.

¢ Should any solid object or liquid fall into
the cabinet, unplug the printer and have
it checked by qualified personnel before
operating it any further.

* Never disassemble the printer.

¢ To disconnect the power cord, pull it out
by the plug. Never pull the power cord
itself.

* When the printer is not going to be used
for an extended period of time,
disconnect the power cord from the wall
outlet.

¢ Do not handle the printer roughly.

¢ To reduce the risk of electrical shock,
always unplug the printer from the
electrical outlet before cleaning and
servicing the printer.

On installation

* Avoid placing the printer in a location
subject to:
— vibration
— high humidity
— excessive dust
— direct sunlight
- extremely high or low temperatures
* Do not use electrical equipment near the
printer. The printer will not work
properly in electromagnetic fields.
* Do not place heavy objects on the
printer.
¢ Leave enough room around the printer
so that the ventilation holes are not
blocked. Blocking these holes may cause
internal heat build-up.
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On the AC adaptor

¢ Be sure to use the AC adaptor supplied
with the printer. Do not use other AC
adaptors, as this may cause a
malfunction.

¢ Do not use the supplied AC adaptor to
other devices.

* Do not use an electrical transformer
(travel converter), as this may cause
overheat or a malfunction.

¢ In case the cord of the AC adaptor is
damaged, never use it any longer, as this
may cause danger.

On moisture condensation

If the printer is brought directly from a
cold location to a warm location or placed
in an extremely warm or humid room,
moisture may condense inside the unit. In
such cases the printer will probably not
work properly and may even develop a
fault if you persist in using it. If moisture
condensation occurs, unplug the AC
power cord of the printer and do not use
the printer for at least one hour.

On transport

When you transport the printer, remove
the ink ribbon, paper tray, AC adaptor, the
memory card, or an external device from
the printer and put the printer and its
peripherals in the original box with the
protective packaging.

If you no longer have the original box and
packing parts, use similar packing material
so that the printer will not be damaged
while being transported.

On cleaning

Clean the cabinet, panel and controls with
a soft dry cloth, or a soft cloth lightly
moistened with a mild detergent solution.
Do not use any type of solvent, such as
alcohol or benzine, which may damage the
finish.



On restrictions on duplication

If duplicating documents with the printer,

pay special attention to the following:

¢ Duplication of banknotes, coins, or
securities is against the law.

¢ Duplication of blank certificates,
licenses, passports, private securities, or
unused postal stamps is also against the
law.

e TV program, films, video tapes, others’
portraits or other materials may be
copyrighted. Unauthorized video
printing of such materials may infringe
the provisions of the copyright law.

On color print packs

Notes on use

On Ink ribbon

* Do not touch the ink ribbon or place the
ink ribbon in a dusty location.
Fingerprints or dust on the ink ribbon
may result in imperfect printing.

¢ Do not rewind the ink ribbon and use
the rewound ink ribbon for printing.
Otherwise, proper printing result will
not be obtained, or even a malfunction
may occur.
If the ink ribbon does not click into
place, remove it and then re-insert it.
Only when the ink ribbon is too slack to
be loaded, wind the spool of the ink
ribbon in the direction of the arrow to

remove the slack.

¢ Never disassemble the ink ribbon.

¢ Do not pull out the ribbon from the ink
ribbon.

¢ Do not remove the ink ribbon while
printing.

On print paper

¢ The side without the imprinting is the
printing surface. Inferior print quality
may result if the printing surface is
contaminated with dust or fingerprints.

Be careful to avoid touching the printing

surface.

¢ Do not bend the paper or tear it off at the
perforations before printing.

¢ To avoid paper jam or malfunctions of
the printer, make sure the following
before printing:

— Do not write or type on the print
paper. Use the oil ink pen to write on
the paper after printing. You cannot
type on the print paper using an ink-
jet printer, etc.

— Do not attach sticker or stamps on the
print paper.

— Do not fold or bend the print paper.

- Total number of print paper does not
exceed 20 sheets.

- Do not print on the used print paper.
Printing an image twice on the same
paper will not make the printed image
thicker.

— Use the print paper for this printer
only.

— Do not use the print paper ejected
without printed.

¢ Do not print on used sheets of print
paper or attempt to rewind the ribbon
inside the ink ribbon. Doing so could
result in damages to the printer.

¢ Do not remove the paper tray while
printing.

Continued
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Notes on storing print packs

* When you are going to store a partially-
used pack of the ink ribbon and print
paper for an extended period of time,
store it in its original bag or in a similar
container.

* When you are going to store print paper
in the paper tray, make sure to close the
tray cover and slide cover.

* Avoid placing the ink ribbon in locations
subject to high temperature, high
humidity, excessive dust, or direct
sunlight. Please store it in a dark and
cold location and use it early. Depending
on the storage status, color elements of
the ink ribbon may deteriorate. Sony
shall assume no responsibilities for any
damage, loss or failed printed results
that may be caused by use of such ink
ribbon.

* Avoid leaving the printing surface of the
print paper in contact with a plastic
eraser or plastic desk mats that includes
vinyl chloride or plasticizer for an
extended period of time; color changes
or deterioration of the printed image
may occur.
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About the Memory
Cards

About the “Memory Stick”

What is “Memory Stick”?

“Memory Stick” is a compact-size IC
recording medium with a large capacity. It
has been designed not only for exchanging/
sharing digital data among “Memory Stick”
complaint products, but also for serving as
an insertable/removable external storage
medium that can save data.

Types of “Memory Stick” that
the printer can use

With the printer, you can use the following
types of “Memory Stick”":

Display- | Delet-
ing/ ing/Sav-
. Printing | ing/For-
Memory Stick type matting
Memory Stick
(Not compatible with OK OK
MagicGate)
Memory Stick oK'l OK*1
(MagicGate Compatible)
MagicGate *] *]
K OK
Memory Stick o
Memory Stick PRO* oK1 oK™
Memory Stick Micro .
(M2 oK™ | oK1

*1 Data reading/recording that requires
“MagicGate” copyright protection cannot be
performed. “MagicGate” is the general name
of a copyright protection technology
developed by Sony using authentication and
encryption.

*2 The printer is equipped with a slot compatible
with both standard-size and Duo-size media.
Without a Memory Stick Duo adaptor, you
can use both standard-size “Memory Stick”
and compact-size “Memory Stick Duo”.



*3 The printer supports FAT32. The printer has
been demonstrated as operable with a
“Memory Stick” with a capacity of 8GB or
smaller manufactured by Sony Corporation.
However, we do not guarantee the operations
of all the “Memory Stick” media.

*4 “M2” is an abbreviation for “Memory Stick
Micro”. In this section, “M2” is used to
describe “Memory Stick Micro”.

For the latest information on available
medium or others, access the following
home page:

http:/ /www.memorystick.com/en/
support/support.html

Select the area where you use your printer,
and then select “Digital Printer” from each
area page.

Notes on use

* For the latest information on the “Memory
Stick” that the printer supports, see the
“Memory Stick” compatibilities information
on the Sony web site.

¢ Do not insert multiple “Memory Stick” at the
same time, which may cause trouble with the
printer.

* When using a “Memory Stick”, make sure to
check correct insertion direction. Wrong usage
may cause trouble with the printer.

¢ When using the “Memory Stick Micro” with
the printer, always insert it into an M2
adaptor.

e If you insert the “Memory Stick Micro” into
the printer without an M2 adaptor, you may
be unable to remove the “Memory Stick
Micro”.

e If you insert the “Memory Stick Micro” into
an M2 adaptor, and insert the M2 adaptor into
the Memory Stick Duo adaptor, the printer
may not operate properly.

* Do not place the “Memory Stick Duo”, an
“Memory Stick Duo”-sized M2 adaptor, or M2
media within the reach of a small child to
prevent him from swallowing it by accident.

* Avoid removing the “Memory Stick” from the
printer while the printer is reading or writing
data.

Data may be damaged in such occasions:

— “Memory Stick” is removed or the printer
is turned off during a read or write
operation.

- “Memory Stick” is used in a location
subject to static electricity or electrical
noises.

We recommend that you save backup of the

important data.

The data processed with the computer may

not be played with the printer.

When you format a “Memory Stick”, use the

format function of the printer or your digital

camera. If you format a “Memory Stick” with
your computer, images may not be displayed
properly.

When you format a “Memory Stick”, all the

data including the protected image files will

be erased. To avoid erasing important data by
accident, make sure to check the content
before formatting.

You cannot record, edit or delete data if you

slide the write-protect switch to LOCK.

Write-protect switch

Connector
a i Write Write
enable protect
position position

-p
i

LOGK =~

Place the label here.

When you use a “Memory Stick Duo” without
the write-protect switch, be careful not to edit
or delete the data by accident.

When you slide the write-protect switch of the
“Memory Stick Duo”, use a thin-pointed
device.

Do not attach any other material than the
supplied label on the labeling position. When
you attach the supplied label, be sure to attach
it to the labeling position. Be careful that the
label does not stick out.

When you write on the memo area of the
attached label, do not write forcefully.

When you carry or store the “Memory Stick”,
put it in the case designed for the “Memory
Stick”.

Continued
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* Do not touch the terminal of the “Memory
Stick” with your hand or a metal object.

¢ Do not strike, bend or drop the “Memory
Stick”.

* Do not disassemble or modify the “Memory
Stick”.

¢ Do not expose the “Memory Stick” to water.

¢ Do not use or store the “Memory Stick” under
the following conditions:

— Locations beyond the required operational
conditions including locations such as the
hot interior of a car parked in the sun or/
and in the summer, the outdoors exposed
to direct sunlight, or a place near a heater.

— Humid locations or locations with corrosive
substances present

About the SD card

The SD card slot of the printer allows you
to use the following:

¢ SD memory card™

® miniSD card

e SDHC memory card™

* MMC standard memory card™

We do not guarantee proper operations for
all types of SD memory cards and MMC
standard memory cards.

*1 The printer has been demonstrated as

operable with an SD card with a capacity of 2
GB or smaller.

*2 The printer has been demonstrated as
operable with an SDHC card with a capacity
of 4 GB or smaller.

*3 The printer has been demonstrated as
operable with an MMC standard memory
card with a capacity of 2 GB or smaller .

Notes on use

* When using a card, make sure to check correct
insertion direction of the card and correct
insertion slot.

* You cannot read or write the data subject to
the copyright protection.

* Do not strike, drop, or bend a card.

¢ Do not disassemble or modify a card.

* Do not expose a card to water.
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¢ Avoid using a card in areas subject to high
humidity, since it may be easily affected by
the humidity.

¢ Do not use or store a card in a location subject
to:

— extremely high temperature such as the hot
inside of a car or the outdoors exposed to a
direct sunlight, or a place near a heater.

— direct sunlight

— high humidity or corrosive substances

— static electricity or electrical noises

* When you carry or store a card, put it in the
case supplied with it.

* Do not remove a card or turn off the printer
while the printer is reading or writing data
and the access indicator is flashing.
Otherwise, data may be rendered unreadable
or erased.

About the CompactFlash card

The CompactFlash card slot of the printer

allows you to use the following;:

e CompactFlash Storage Card (Type I/
Type II) and CF+Card (Type I/ Type II)-
compatible CompactFlash Storage
Card™.

® Micro Drive

¢ COMPACT VAULT

You can also use the following by using a

commercially available CompactFlash card

adaptor™:

e Smart Media card™®

¢ xD-Picture Card"™

However, we do not guarantee proper

operations for all types of CompactFlash

cards.

*4 Use a CompactFlash card with a power
specification of 3.3V or 3.3V/5V. You cannot
use a type for 3V or 5V only. Do not insert
other types of CompactFlash card into the
printer’s insertion slot. The printer may be
damaged.

*5 When using a commercially available
CompactFlash card adaptor, refer to the
operating instructions of the adaptor you use
for how to install the card and adaptor.



When using the CompactFlash card adaptor,
the write-protected card may not work

properly.
Notes on use

* When using a card, make sure to check correct
insertion direction of the card and correct
insertion slot.

Do not strike, drop, or bend a card.

* Do not disassemble or modify a card.

* Do not expose a card to water.

* Avoid using a card in areas subject to high
humidity, since it may be easily affected by
the humidity.

* Do not use or store a card in a location subject
to:

— extremely high temperature such as the hot
inside of a car or the outdoors exposed to a
direct sunlight, or a place near a heater.

— direct sunlight

— high humidity or corrosive substances

— static electricity or electrical noises

* When you carry or store a card, put it in the
case supplied with it.

* Do not remove a card or turn off the printer

while the printer is reading or writing data

and the access indicator is flashing.

Otherwise, data may be rendered unreadable

or erased.

Specifications

B Printer

Printing method
Dye sublimation printing (Yellow/
Magenta/Cyan 3 pass)
Resolution
300 (H) x 300 (V) dpi
Image processing per dot
256 levels processing (8 bits for each
Yellow /Magenta/Cyan)
Printing size
P (Post Card/4 x 6 inch) size:
101.6 x 152.4 mm (maximum,
borderless)
Printing time (per sheet)
Memory card >3
Approx. 45 sec.
PictBridge™":
Via PC:
Input/Output connectors
USB (Full Speed) for PC connection
PictBridge/EXT INTERFACE
connector
Slot
“Memory Stick” insertion slot

Approx. 56 sec.
Approx. 50 sec.

SD Card insertion slot
CompactFlash card insertion slot
Compatible image file formats

JPEG: DCEF 2.0 compatible, Exif 2.21
compatible, JFIF7

TIFF: Exif 2.21 compatible

BMP™®: 1, 4, 8, 16, 24, 32 bits Windows
format

Some image file formats are not
compatible.

Continued
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Maximum number of pixels to be

handled
8 000(H) x 6 000(V) dots
(Excluding Index Print and part of
Creative Print)

Maximum number of files to be handled
9999 files for a memory card/an
external device

Ink ribbon/Print Paper
See supplied “Read This First”.

LCD screen
LCD panel:

DPP-FP70: 6.2 cm (2.5 type) TFT
drive
DPP-FP90: 9.0 cm (3.6 type) TFT
drive
Total number of dots:
DPP-FP70: 115 200 (480 x 240)
DPP-FP90: 230 400 (320 RGB x 240)

Power requirements
DC IN jack, DC 24V

Power consumption
While printing: 80 W (maximum)
On standby mode: less than 1W

Operating temperature
5°Cto 35 °C (41 °F to 95 °F)

Dimensions
[DPP-FP70]

Height: Approx. 63 mm
(2'/,inches) (printer)
Approx. 72 mm
(27/, inches) (including
LCD projecting parts)
Width:  Approx. 180 mm
(71!/,inches)
Depth:  Approx. 137 mm
(51/,inches) (excluding
a handle)
Approx. 149 mm
(57/,inches)
(including a handle)
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[DPP-FP90]
Height: Approx. 66 mm

(27°/inches)

Approx. 180 mm
(71/inches)

Approx. 137 mm
(51/,inches)
(excluding a handle)

Width:

Depth:

Approx. 149 mm
(57/,inches)
(including a handle)
Depth when the paper tray is
installed: Approx. 169 mm (6°3/,
inches) longer than the above depth.
Mass
DPP-FP70: Approx. 1.1kg (21b 7 oz)
DPP-FP90: Approx. 1.2 kg (21b 10 oz)
(excluding the paper tray, ink ribbon,
AC power adaptor)
Supplied accessories
See supplied “Read This First”.

B AC power adaptor AC-52422

Power requirements
AC 100V to 240V, 50/60 Hz,
15At00.75 A
Rated output voltage
DC24V,22 A (Peak 3.7 A, 6.5 s)
Operating temperature
5°Cto035°C (41 ‘Fto 95 °F)
Dimensions
Approx. 60 x 30.5 x 122 mm
2 3/8 x 1 1/4x4 7/8 inches)
(w/h/d, excluding protruding parts
and cables)
Mass
Approx. 305 g (11 oz)

Design and specifications are subject to
change without notice.



* The total number of sheets of P size print paper

that the printer can print is estimated to be
approximately 2,000. For the total number of
sheets, please check “Printer Information

Display” of the “Display/Printer setup” menu
(page 34).

*1:

*2:

*3:

Print Settings: Borderless, No time stamp,
AutoFine Print 4: ON (Photo)

When printing a photo (4.22 MB file size)
taken by a Sony digital still camera
containing effective picture elements of
approximately 10,100,000 or equivalent.
Print Speed: Time from when the PRINT
button is pressed to when printing is
finished. (The printing time may vary
depending on a used equipment, a format
of an image, a used memory card, settings
of an application and operating conditions.)

Printing range

(1 128 dots)

*4:

*6:

*7:

*8:

When printing from a “Memory Stick PRO
Duo” inserted in the printer s slot

When printing via DSC-N2 connected by
USB cable. Time from when the “PRINT”
button on the OSD of the camera is pressed
to when the printing is finished.

The time for data processing and
transferring is excluded.

Baseline JPEG with 4:4:4, 4:2:2, or 4:2:0
format

You cannot print using the Picture Motion
Browser.

Customer support home page

The latest support information is available at
the following home page address:

http:/ /www.sony.net/

I
::
i
;I (1200 dots)
|
N
1

P size
152.4 mm/6 inch
(1 800 dots)
|
I >
el e e e e el 1
I
|
95.5 mm/ | 101.6 mm/
3 7lginch [ 4 inch
I
|
|
1

146.3 mm/5 7/ inch

(1 728 dots)

Border print range

Borderless print
range

Perforations

The above illustrations are those when an image with a 2:3 aspect ratio is printed.

The printing range differs for a border or a borderless print.

77 GB

uoIl_WIOUI [RUOILIPPY



Glossary

DCF (Design rule for Camera File system)
This camera conforms with the DCF
(Design rule for Camera File system)
standard established by JEITA (Japan
Electronics and Information Technology
Industries Association) to maintain file
exchangeability and compatibility
between digital cameras and related
products. Complete exchangeability and
compatibility, however, are not
guaranteed.

DPOF (Digital Print Order Format)
The format used to record the
information necessary for automatically
printing images shot by a digital camera
at a printing shop or with a home-use
printer. The printer supports DPOF
printing and can automatically print the
preset number of copies of the DPOF
preset images.

Exif 2.21 (Exif Print)
Exif (Exchangeable image file format for
digital cameras) Print is a global
standard for digital photo printing. A
digital camera supporting Exif Print
stores the data relevant to the conditions
of shooting as each shot is taken. The
printer utilises the Exif Print data stored
in each image file to ensure the printed
result matches the original shot as
closely as possible™.

*1 When the “Auto Fine Print 4” is enabled
and an image (JPEG file) is shot by an Exif
Print (Exif 2.21)-compliant digital camera,
the image is automatically adjusted to its
optimum picture quality and printed.
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"Memory Stick”/CompactFlash card/SD
card
Compact, light, removable storage
media. For details see pages 72 to 75.

PictBridge
A standard specified by Camera &
Imaging Products Association that
allows you to connect PictBridge-
complaint digital camera directly to the
printer without a PC, enabling direct
printing on the spot.

Thumbnails
Miniature images for representing the
original images that are stored in the
image files taken by a digital camera.
The printer uses thumbnails in the image
list.



Superimpose characters glossary

You can use the characters here to superimpose onto an image. Please take a picture of the
desired characters in advance, and follow the procedures for superimposing handwriting
in pages 23 and 24 to trim the necessary portion and superimpose it onto an image.

Happy New Year!

Seasons Greetings

Happy Holidays

Thank Youl!

Happy Birthday

79 GB

uoIl_WIOUI [RUOILIPPY



Happy New Year!
Seasons Greetings
Fappy Holidays

Vtank Yoe!

Fappy Bothday



Additional information
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Index

A

Adjusting an image 14
All printing 11
Associated file indication
8

Auto Fine Print4 31, 47

AUTO TOUCH-UP
10, 47

B
Bluetooth device 36

Borders/Borderless
31, 47

C

Calendar 20

Changing the display 8

Cleaning 68

Color print packs
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% Printed using VOC (Volatile Organic Compound)-free vegetable oil based ink.

Sony Corporation  Printed in China
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